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Explanation of Symbols

CAUTION: Risk of Danger! Wherever this symbol appears, always consult
note in this manual for further information before proceeding. This symbol
identifies components that pose a risk of personal injury or damage to the
instrument if improperly handled.

CAUTION: Risk of Electrical Shock! This symbol identifies components that
pose a risk of electrical shock if improperly handled.

CAUTION: Hot Surface! This symbol identifies components that pose a risk
of personal injury due to excessive heat if improperly handled.

Safety Warnings

Warning: Operating the DNA Engine® cycler before reading this manual can
constitute a personal injury hazard. Only qualified laboratory personnel
trained in the safe use of electrical equipment should operate these
machines.

Warning: Do not open or attempt to repair the DNA Engine or any Alpha™

unit, or other DNA Engine accessory. Doing so will void your warranties and
can put you at risk for electrical shock. Return the DNA Engine instrument to
the factory (US customers) or an authorized distributor (all other customers) if
repairs are needed.

Warning: All Alpha unit blocks can become hot enough during the course of
normal operation to cause burns or cause liquids to boil explosively. Wear
safety goggles or other eye protection at all times during operation.

Warning: The DNA Engine instruments incorporate neutral fusing, which
means that live power may still be available inside the machines even when a
fuse has blown or been removed. Never open the DNA Engine or DNA Engine
Tetrad base; you could receive a serious electrical shock. Opening the base
will also void your warranties.

Caution: Never remove an Alpha unit from the DNA Engine with the power
turned on and a program running. Doing so can cause electrical arcing that
can melt the contacts in the connector joining the Alpha unit to the DNA
Engine.



Safe Use Guidelines

The DNA Engine instruments are designed to be safe to operate under the following
conditions:

•    Indoor use
•    Altitude up to 2000 m
•    Ambient temperature 5–31°C
•    Maximum relative humidity 90%, noncondensing
•    Transient overvoltage per Installation Category II, IEC 664
•    Pollution degree 2, in accordance with IEC 664

Electromagnetic Interference

These devices comply with Part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) these devices may not cause harmful interference, and (2) these devices
must accept any interference received, including interference that may cause undesired
operation.

These devices have been tested and found to comply with the EMC standards for emis-
sions and susceptibility established by the European Union at time of manufacture.

This digital apparatus does not exceed the Class A limits for radio noise emissions from dig-
ital apparatus set out in the Radio Interference Regulations of the Canadian Department of
Communications.

LE PRESENT APPAREIL NUMERIQUE N’EMET PAS DE BRUITS RADIOELECTRIQUES
DEPASSANT LES LIMITES APPLICABLES AUX APPAREILS NUMERIQUES DE CLASS A
PRESCRITES DANS LE REGLEMENT SUR LE BROUILLAGE RADIOELECTRIQUE
EDICTE PAR LE MINISTERE DES COMMUNICATIONS DU CANADA.

FCC Warning

Warning: Changes or modifications to these units not expressly approved by the party
responsible for compliance could void the user’s authority to operate the equipment.

This equipment qualifies as an “Exempted device” under Section 15.103(c) of the FCC Rules.
Nonetheless, the design has been verified to comply within limits for Class “A” digital device.

Note: This equipment has been tested and found to comply with the limits for a Class A
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radiofrequency
energy and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this equipment in a residential
area is likely to cause harmful interference in which case the user will be required to correct
the interference at his own expense.
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Documentation Conventions

Typographic Conventions

The names of keyboard keys are set in double angle brackets: 

Example «Proceed»

Items in programming menus are italicized:

Example Select Edit from the Main Menu.

Graphic Conventions

The programming screens displayed in the LCD window are represented by a box
containing four lines of text:

Example

Terminology

A programming option is termed “selected” when the cursor is positioned in front of it.
Use the «Select» keys (see fig. 2-2) to move the cursor. In some screens selected items
are also displayed in all-capital letters.

Run: 2-STEP

1= 92.0 for 0:05

Cycle: 1

Calc:  65.0
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Meet the DNA Engine® Thermal Cycler

Thank you for purchasing a Bio-Rad PTC-0200 DNA Engine thermal cycler. Designed
by a team of molecular biologists and engineers, the DNA Engine will meet your
needs for a versatile, easy-to-use, reliable, and compact programmable thermal
cycler.

• Interchangeable sample blocks—the Alpha™ unit family— that accommodate
many types of tubes, microplates, and slides

• Hot Bonnet® heated lid (or its remote-controlled version, the motorized Moto
Alpha™ Moto Alpha unit) for oil-free cycling

• Intuitive software with easy-to-read interface for quick and painless programming,
editing, file management, password protection, and much more

• Choice of calculated sample temperature control for highest speed and accuracy, or
block control for compatibility with protocols designed for a variety of instrument types

• Space-saving design for easy setup and transportation

• Instant Incubate feature for continuous-temperature incubations

• Networking of up to 15 machines, for convenient remote operation and documentation
of runs

• Customizable factory-installed protocols

Using This Manual

This manual contains all the information you need to operate your DNA Engine safely
and productively:

• Chapter 2 acquaints you with the physical characteristics of the DNA Engine.

• Chapters 3–5 present the basics of installing and operating the DNA Engine.

• Chapters 6 and 7 describe programming the DNA Engine.

• Chapter 8 outlines the utilities available for the DNA Engine.

• Chapter 9 describes how to network and remotely operate the DNA Engine.

• Chapter 10 explains the proper maintenance of the DNA Engine.

• Chapter 11 offers troubleshooting information for the DNA Engine.
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Important Safety Information

Safe operation of the DNA Engine begins with a complete understanding of how the
machine works. Please read this entire manual before attempting to operate the DNA
Engine. Do not allow anyone who has not read this manual to operate the machine. 

The DNA Engine can generate enough heat to inflict serious burns and can deliver
strong electrical shocks if not used according to the instructions in this manual. Please
read the safety warnings and guidelines at the front of this manual, and exercise all pre-
cautions outlined in them.
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(Figure 2-1)

Control Panel

(Figure 2-2)

DNA Engine  Operations Manual

2-2 Tech Support: 1-800-4BIORAD • 1-800-424-6723 • www.bio-rad.com 

Alpha™ unit, lid closed
Thumbwheel

Air intake vents

Control panel

Air exhaust vents
(also on other side)

Block status lights

Instant incubation key

Power light

Block key

LCD window

Left and right
selection keys

Proceed key

Cancel key
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Back View

(Figure 2-3)

Bottom View

(Figure 2-4)

Air exhaust vents
(also on other side)

Alpha unit

Air intake vents

Alpha unit handle

Power cord jack

RS-232 port IEEE-488 port

Parallel printer port

Back Front

Air intake vents



Alpha Units 

Single-Block Models

60V Alpha unit: Holds 60 x 0.5 ml tubes

96V Alpha unit: Holds 96 x 0.2 ml tubes or
one 96-well microplate

384 Alpha unit:  Holds one 384-well
microplate or one 96-well
microplate

Dual-Block Models

30/30 Dual Alpha™ Holds 2 x 30 x 0.5
unit: ml tubes

30/48 Dual Alpha unit:  Holds 1 x 30 x 0.5 ml
tubes and 1 x 48 x
0.2 ml tubes

48/48 Dual Alpha unit:  Holds 2 x 48 x 0.2 ml
tubes or half plates

Slide Block

Slide Chambers™ Alpha unit: Holds 2 x 16
standard slides

Moto Alpha™ unit 

Permits remote control of Alpha unit lid opening;
available in 96-well, 384-well, and flat-block 
formats.

DNA Engine  Operations Manual
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Specifications

Thermal range: –5° to 105°C, but no more than 30°C below ambient
temperature (4° to 100°C for the Slide Chambers Alpha unit)

Thermal accuracy: ±0.3°C of programmed target at 90°C, NIST-traceable

Thermal uniformity: ±0.4°C well-to-well within 30 seconds of arrival at 90°C
(for most Alpha units; see specifications for individual
Alpha units)

Ramping speed: Up to 3°C/sec for all single- and dual-block Alpha units;
up to 1.2°C/sec for the Slide Chambers Alpha unit.

Sample capacity: Varies with installed Alpha unit

Line voltage: DNA Engine® cycler: 100–240 VAC rms (no adjustment
needed among voltages within these ranges)

Frequency: 50–60 Hz single phase

Power: DNA Engine cycler: 850 W maximum

Fuses: Two 6.3 A, 250 V, 5 x 20 mm

Displays: One 20 x 4 LCD alphanumeric display

Ports: One 25-pin 8-bit parallel interface printer port
One 9-pin RS-232 serial port for printer or remote use
One IEEE-488 bidirectional general purpose interface bus

Memory: 400 typical programs in up to 12 individual folders
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Gradient Specifications (96V Alpha module only)

Accuracy: +0.3°C of programmed target at end columns, 30
seconds after the timer starts for the gradient step,
NIST–traceable

Column uniformity: +0.4°C, well–to–well within column, within 30 
seconds of reaching target temperature

Gradient calculator accuracy: +0.4°C of actual well temperature

Lowest programmable temp: 30°C 

Highest programmable temp: 105°C
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Packing Checklist

After unpacking the DNA Engine® cycler, check to see that you have received the fol-
lowing:

•   One DNA Engine base

•   One Alpha™ unit (more if additional units were ordered)

•   Two spare fuses

•   One power cord

•  DNA Engine Peltier Thermal Cycler, Operations Manual (this document)

If any of these components are missing or damaged, contact Bio-Rad or the authorized dis-
tributor from whom you purchased the DNA Engine cycler to obtain a replacement. Please
save the original packing materials in case you need to return the DNA Engine cycler for
service. See appendix A for warranty information.

Setting Up the DNA Engine Cycler 

The DNA Engine cycler requires only minimal assembly: plugging in the power cord and
inserting an Alpha unit. Insert the power cord plug into its jack at the back of the machine
(see fig. 2-3 for location of jack), then plug the cord into an electrical outlet. With the
machine turned off, insert an Alpha unit (see “Installing an Alpha Unit,” chapter 4).

Caution: Do not insert or remove an Alpha unit with the DNA Engine cycler
turned on; electrical arcing can result. Read the safety warning at
the front of this manual regarding electrical safety when inserting or
removing an Alpha unit. 

Environmental Requirements

Ensure that the area where the DNA Engine cycler is installed meets the following
conditions, for reasons of safety and performance:

•   Nonexplosive environment

•   Normal air pressure (altitude below 2000 m)

•   Ambient temperature 5–31°C

•   Relative humidity up to 90% 

•   Unobstructed access to air that is 31°C or cooler (see below)
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•   Protection from excessive heat and accidental spills (Do not place the DNA Engine
cycler near such heat sources as radiators, and protect it from danger of having
water or other fluids splashed on it, which can cause shorting in its electrical cir-
cuits.)

Power Supply Requirements

The DNA Engine cycler requires 100–240 VAC, 50–60 Hz, and a grounded outlet. The DNA
Engine cycler can use current in the specified range without adjustment, so there is no
voltage-setting switch.

Power cords for outlets other than the US 120V outlet may be purchased from computer
stores, since they are also used for most desktop computers and printers and meet
international standard IEC-320. The power cord must be rated to carry at least 10 A at
125 V or 250 V, depending on the voltage available in your nation. The quality of the
power cord can be further ensured by making certain it is inscribed with the trademark
of UL, CSA, TUV, VDE, or another national testing agency. 

Note: Do not cut the supplied 120 V power cord and attach a different connector.
Use a one-piece molded connector of the type specified above.

Air Supply Requirements

The DNA Engine cycler requires a constant supply of air that is 31°C or cooler in order
to remove heat from the Alpha unit’s heat sink. Air is taken in from vents at the front,
back, and bottom of the machine and exhausted from vents on both sides (see figs. 2-
1, 2-3, and 2-4). If the air supply is inadequate or too hot, the machine can overheat,
causing performance problems, software error messages (particularly “HS Overheating”
and “Slow Block Cycling”), and even automatic shutdowns. Special attention should be
paid to airflow and air temperature in robotics installations of DNA Engine cyclers.

Ensuring an Adequate Air Supply

•   Do not block the air intake vents. 

Position the DNA Engine cycler at least 10 cm from vertical surfaces and other thermal
cyclers (greater distances may be required; see below). Do not put loose papers under
the machine; they can be sucked into the air intake vents on the bottom of the machine. 

•   Do not allow dust or debris to collect in the air intake vents. 

The bottom air vents are particularly liable to collect dust and debris, sometimes
completely clogging up. Check for dust and debris every few months, and clean the
intake vents as needed. Remove light collections of dust with a soft-bristle brush or damp
cloth. Severe collections of dust and debris should be vacuumed out. Turn the machine
off prior to cleaning or vacuuming air vents. 



DNA Engine  Operations Manual

3-4 Tech Support: 1-800-4BIORAD • 1-800-424-6723 • www.bio-rad.com

Ensuring That Air Is Cool Enough 

•  Do not position two or more DNA Engine cyclers (or other thermal cyclers) so that
the hot exhaust air of one blows directly into the air intake vents of another.

•  Make sure the DNA Engine cycler receives air that is 31°C or cooler by measuring
the temperature of air entering the machine through its air intake vents.

Place the DNA Engine cycler where you plan to use it, and turn it on. Try to reproduce
what will be typical operating conditions for the machine in that location, particularly
any heat-producing factors (e.g., nearby equipment running, window blinds open,
lights on). Run a typical protocol (e.g., 2-Step) for 30 minutes to warm up the DNA
Engine cycler, then measure the air temperature at the back air intake vents. If more
than one machine is involved, measure the air temperature for each. 

If the air intake temperature of any machine is warmer than 31°C, use table 3-1 to 
troubleshoot the problem. Some experimentation may be required to determine the
best solution when more than one cause is involved. After taking steps to solve the
problem, verify that the temperature of the air entering the air intake vents has been
lowered, using the procedure outlined above.

Requirements for Robotics Installations

Robotics installations require special attention to airflow and air temperature. Typically in
these installations, DNA Engine cyclers and other thermal cyclers are crowded into a
small area, along with other heat-generating equipment. Overheating can quickly occur
when many of these machines are operating at once, unless preventive measures are
taken.

Follow the procedures described above to ensure adequate airflow and an air intake
temperature of 31°C or cooler. Air intake temperature must be verified by measurement.

Do not use oil to thermally couple sample vessels to the blocks of machines in a robotics
installation. Oil makes plates difficult to remove.

Table 3-1 Troubleshooting Air Supply Problems

Cause Possible Remedies

Air circulation is poor. Provide more space around machine or adjacent room ventilation.

Ambient air temperature is
high.

Adjust air conditioning to lower ambient air temperature.

Machine is in warm part of
room.

Move machine away from, or protect machine from, such heat
sources as radiators, heaters, other equipment, or bright sunlight.

Machines are crowded.
Arrange machines so that warm exhaust air does not enter intake
vents.
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Turning the DNA Engine® Cycler On

Move the power switch to “1” (the “On” position). The fan will turn on and the power light
on the keyboard will glow red.  In most cases a self-test of the heat pumps will begin
running (see note below). Its progress is tracked on a screen in the LCD window:

This screen disappears in 1 minute. If a problem is detected, the display shows an error
message. 

Note: If the Alpha™ unit’s block or heat sink is not at ambient temperature (typically
because the Alpha unit was recently in use), the machine will skip the self-test.

If the self-test does not detect any problems, the Main Menu is displayed:

The DNA Engine cycler is now ready to execute programs. 

Understanding the Main Menu

The Main Menu is the common access point to all programming and machine configuration
screens.

•     Run: Executes a program.

•     Enter: Allows new programs to be entered.

•     List: Accesses utilities that display or print a program’s steps.

•     Edit: Allows modification of stored programs.

•     Files: Accesses file management utilities.

•     Setup: Accesses machine and networking configuration screens.

PTC-200:

Self testing
.

PTC-200:
_RUN     Enter
List    Edit
Files   Setup
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Using the Control Panel

The control panel (see fig. 2-2) includes operation keys, status indicator lights, an LCD
window for displaying programming and machine status text, and a numeric keypad
for entering values into programs. 

Operation Keys 

• Select keys (left and right arrows): Move the cursor one space or option to the left or
right in the LCD window; during a protocol run, display time and cycle information.

• Proceed: Accepts a selected menu or screen option; during a protocol run, advances
the program to its next step.

• Cancel: Terminates a running protocol; during program creation or editing, cancels
the last entry.

• Stop: Terminates a running protocol.

• Pause: Pauses a protocol during execution; accesses Japanese Katakana syllabary.

• Instant Incubate: Initiates a program that sets up the DNA Engine cycler as a
simple  incubator.

• Block: Selects a different block when using a Dual Alpha™ unit; switches between
block screens and the Main Menu in the LCD window during a protocol run.

Status Indicator Lights

•   Power light: Glows red when the DNA Engine cycler is powered up.

•   Block Status lights: Indicate which blocks are in use; glow red when blocks are
heating and green when blocks are cooling. 

Using the Data Ports

The DNA Engine cycler has three data ports located at the rear of the machine: an RS-
232 port, an IEEE-488 port, and a parallel (printer) port. See chapters 8 and 9 for
information on using these ports to network machines, connect them to a computer, or
print data.
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Operating Alpha Units

Note: Operation of the Slide Chambers™ Alpha unit will not be discussed, owing to
the many differences between this type of Alpha unit and the others. Please see the
Slide Chambers Operations Manual for operating instructions.

Note: Moto Alpha™ units are installed and removed as described below. See the
Moto Alpha Unit Operations Manual for instructions on opening and closing Moto
Alpha units.

Installing an Alpha Unit

1. Turn the DNA Engine cycler off (see the Caution on p. 4-5).

2. Hold the Alpha unit at its front and back edges. 

3. Lower the Alpha unit into the DNA Engine base, leaving at least 3cm between the
front edge of the Alpha unit and the front of the base. 

4. Raise the handle at the back of the Alpha unit, and slide the block forward as far
as it will go (fig. 4-1A). 

5. Push the handle down until it is completely vertical (fig. 4-1B); firm pressure may
be required. A definite click signals that the Alpha unit’s connectors have mated
with the DNA Engine cycler’s connectors. 

When the handle is in the down position, the Alpha unit is locked into place. 

Figure 4-1 Installing an Alpha unit.

A B
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Removing an Alpha Unit

1. Turn the DNA Engine cycler off (see the Caution below).

2. Pull upward on the handle. When the lock releases, you will hear a click, and the
Alpha unit will slide a little toward the back of the DNA Engine cycler. The elec-
trical connectors of the Alpha unit and the DNA Engine cycler are now
disengaged, so there is no danger of electrical shock.

3. Slide the Alpha unit toward the rear of the DNA Engine cycler about 3 cm.

4. Grasp the front and back edges of the Alpha unit, and lift it out of the machine.

Caution: Do not insert or remove an Alpha unit with the DNA Engine
cycler turned on; electrical arcing can result. Read the safety
warning at the front of this manual regarding electrical safety
when inserting or removing an Alpha unit. 

Opening an Alpha Unit 

Grip the front edge of the top lever of the Hot Bonnet® lid as shown in figure 4-2A,
and pull upward firmly. The top lever will pop open to reveal the entire thumbwheel
(fig. 4-2B). Continue pulling upward to open the Hot Bonnet lid. The Hot Bonnet lid
will tip backward, revealing the entire block. 

Caution: Do not pull on the thumbwheel to open the unit. This can
damage the Hot Bonnet lid’s closing mechanism.

Closing an Alpha Unit

Press down on the top lever. The lever will close down over the thumbwheel as the
Hot Bonnet lid closes down over the sample block. A click signifies that the
Hot Bonnet lid’s latch has engaged. 

Figure 4-2 Opening an Alpha unit.

A B
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Selecting the Correct Sample Vessel

The DNA Engine cycler’s wide variety of interchangeable Alpha units affords you great
scope in choosing sample vessels. Keep in mind that differences in tube and plate com-
position and wall thickness among the many brands available can affect reaction
performance. Protocols may require some adjustment to ensure optimum performance
when using a new vessel type. Bio-Rad offers a full range of tubes and microplates, man-
ufactured to the specifications of each type of Alpha unit to ensure a precise fit. See
chapter appendix 4-A for a complete list. 

0.5 ml Tubes

Make sure thick-walled 0.5 ml tubes fit the wells snugly. Since these tubes were originally
designed for centrifuges, some brands may not fit tightly in thermal cycler wells. Thin-walled
0.5 ml tubes were specifically designed for thermal cycling, and the higher quality brands
provide a good and consistent fit. Bio-Rad provides thin- and thick-walled 0.5 ml tubes
designed for precise block fit.

0.2 ml Tubes

All types of thin-walled 0.2 ml tubes may be used. Bio-Rad sells high-quality 0.2 ml
tubes in a number of styles, including individual tubes and strips.

Microplates

A variety of 96-well polycarbonate or polypropylene microplates can be used in 96-well
Alpha units as long as they fit the wells snugly. Polypropylene microplates are usually
preferred because they exhibit very low protein binding and, unlike polycarbonate
microplates, do not lose water vapor through the vessel walls. This allows smaller
sample volumes to be used — as little as 5–10 µl. Polypropylene microplates and com-
patible sealing systems are available from Bio-Rad. (See “Sealing Sample Vessels” on
the next page for a description of available sealing systems from Bio-Rad.)

Thin-Walled Vs. Thick-Walled Tubes

The thickness of sample tubes directly affects the speed of sample heating and thus
the amount of time required for incubations. Thick-walled tubes delay sample heating,
since heat transfers more slowly through the tubes’ walls. For the earliest types of
thermal cyclers this delay mattered little. These machines’ ramping rates were so slow
(below 1°C/sec) that there was plenty of time for heat to transfer through the tube wall
to the sample, during a given incubation.

Modern thermal cyclers have much faster ramping rates (up to 2–3°C/sec), so the faster
heat transfer provided by thin-walled tubes allows protocols to be significantly short-
ened. On average, about 30 seconds can be saved per cycle by using thin-walled
tubes, for an overall savings of 15 minutes in a 30-cycle run.
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Sealing Sample Vessels 

To avoid changing the concentration of reactants, steps must be taken to prevent the
evaporation of water from reaction mixtures during thermal cycling. Only a layer of oil
or wax will completely prevent evaporation from the surface of the reaction fluid.
However, an adequate degree of protection can be achieved by sealing vessels with
caps, film, adhesive seals, or mats, then cycling the samples using the heated lid to
prevent condensation.

Sealing with Oil or Wax

Mineral oil, silicone oil, paraffin wax, or Chill-out™ liquid wax may be used to seal samples.
Use only a small amount of oil or wax; 1–3 drops (15–50µl) are usually sufficient. (Include
this volume in the total volume when setting up a calculated-control protocol; see
“Choosing a Temperature Control Mode” in Chapter 5.) Use the same amount of oil or
wax in all sample vessels to ensure a uniform thermal profile.

Most paraffin waxes solidify at room temperature. The wax can then be pierced with a
micropipette and the samples drawn off from below the wax. Silicone oil and mineral oil
can be poured off or aspirated from tubes if the samples are first frozen (–15° to –20°C).
The samples are usually pure enough for analysis without an extraction.

Chill-out liquid wax (available from Bio-Rad) is an easy-to-use alternative to oil. This puri-
fied paraffinic oil solidifies at 10°C and is liquid at room temperature. By programming a
hold at low temperature, the wax can be solidified at the end of a run. A pipette tip can
then be used to pierce the wax in the tubes and remove the samples. The wax is available
in a clear, optical-assay grade or dyed red to assist in monitoring its use. The red dye has
no adverse effects on fluorescent gel analysis of reaction products.

Sealing with the Hot Bonnet Lid

The Hot Bonnet lid’s heated inner surface maintains the air in the upper part of
sample vessels at a higher temperature than the reaction mixture. This prevents con-
densation of evaporated water vapor onto the vessel walls and lid, so that solution
concentrations are unchanged by thermal cycling. The Hot Bonnet lid also exerts
pressure on the tops of vessels loaded into the block, helping to maintain a vapor-
tight seal and to firmly seat tubes or the plate in the block.  

Caps, film, adhesive seals, or mats must be used along with the Hot Bonnet lid to prevent
evaporative losses.

Note: When tubes are cooled to below-ambient temperatures, a ring of condensation
may form in tubes above the liquid level but below the top of the sample block. This
is not a cause for concern since it occurs only at the final cool-down step, when
thermal cycling is complete.
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Microseal® ‘A’ film offers a quick alternative to sealing microplates or arrays of tube
strips. This film is specially designed to seal tightly during cycling, yet release smoothly
to minimize the risk of aerosol formation and cross-contamination of samples.
Microseal ‘A’ film is easily cut for use with fewer than 96 samples.

Microseal ‘B’ adhesive seals feature an aggressive adhesive, effective from –20°C to
110°C, which allows secure sample storage or transport before and after cycling. The
clear polyester backing allows easy inspection of sample wells. Microseal ‘B’ clear,
adhesive seals are ideal for thermal cycling in all polypropylene and polystyrene
microplates.

Microseal ‘F’ aluminized foil acts as a barrier against evaporation from –20°C to 105°C.
It is thin enough to pierce with a pipet tip for recovery of sample from individual wells. 

96-well PCR plate sealing mats (223-9442) are an economical means to seal 96-well
microplates. An array of 96 dimples on the mat helps orient it on the microplate and pre-
vents the mat from sticking to the heated lid. The mats may be cleaned with sodium
hypochlorite (bleach) for reuse, and they are autoclavable.

Microseal ‘P’/’P+’ pads are designed for use in applications such as cycle sequencing, in
which several successive runs may be sealed with the same pad. Use ‘P’ pads with the
original version of Power Bonnet™ lids (ALP-1296 and ALP-1238) and use ‘P+’ pads with
the newer-design Moto Alpha™ units (ALP-2296, ALP- 2238, ALP-2200, and ALP-2201).

Adjusting the Hot Bonnet Lid’s Pressure

The pressure exerted by the inner lid of the Hot Bonnet lid must be manually adjusted
to fit the sample vessels being used in a given reaction. Once set, the Hot Bonnet lid
can be opened and closed repeatedly without readjustment as long as neither the
tube or microplate type nor the sealing method changes. Any change in vessel type
or sealing method requires readjustment of the Hot Bonnet lid.

Follow these steps to adjust the pressure exerted by the Hot Bonnet inner lid:

1. Make sure the block’s wells are clean. Even tiny amounts of extraneous material
can interfere with the proper seating of a microplate or tubes, which would prevent
the inner lid from exerting uniform pressure on the loaded microplate or tubes.

2. Open the Hot Bonnet lid. Turn the green thumbwheel all the way counterclock-
wise to completely raise the inner lid.

3. Load either a microplate or at least eight individual tubes into the sample block. The
inner lid pivots around a central point, so it is important to distribute individual tubes
evenly. Load at least four tubes in the center of the block and at least one tube in
each of the four corners of the block. If using a sealing film or mat, apply it to the
loaded microplate according to the manufacturer’s directions.
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4. Close the Hot Bonnet lid by pressing down on the top lever. Turn the thumbwheel
clockwise to lower the Hot Bonnet inner lid onto the loaded microplate/tubes. The
thumbwheel turns easily at first since the inner lid has not yet come into contact
with anything. Stop turning the thumbwheel when you feel increased resistance,
which indicates that the inner lid has touched the microplate/tubes.

5. Open the Hot Bonnet lid. Turn the thumbwheel clockwise an extra half to three-quar-
ters of a turn to set an appropriate lid pressure. 

Caution: Do not turn the thumbwheel more than three-quarters of a
turn. This can make it hard or impossible to close the lid and
puts excessive strain on the latch holding the lid closed.

An extra half to three-quarters of a turn ensures the correct pressure for most types of
reaction vessels. Some empirical testing may be required to determine the optimum
pressure required for certain vessels. Once this pressure has been determined, the
thumbwheel position that delivers it may be marked with a colored marking pen or
piece of tape.

Note: As an aid in gauging how much the thumbwheel has been turned, mark it at
the quarter turn positions, or every sixth bump on the thumbwheel (there are 24 total
bumps).

6. Close the Hot Bonnet lid. 

Loading Sample Vessels into the Block

When using a small number of tubes, they should all be placed in the center of the block,
to ensure uniform thermal cycling of all samples. Also load at least one empty tube in
each corner of the block, to ensure that the Hot Bonnet lid exerts even pressure on the
sample tubes (see “Adjusting the Hot Bonnet Lid Pressure,” above).

To ensure uniform heating and cooling of samples, sample vessels must be in complete
contact with the block. Adequate contact is ensured by always doing the following:

•     Ensure that the block is clean before loading samples. (See chapter 10 for
cleaning instructions.)

•     Firmly press individual tubes or the microplate into the block wells.
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Using Oil to Thermally Couple Sample Vessels to the Block

With two exceptions (see below), Bio-Rad does not recommend using oil to thermally
couple sample vessels to the block, for the following reasons: 

• Calculated-control protocols do not run accurately when oil is used. 

• Oil traps dirt, which interferes with thermal contact between vessels and the block.

Caution: If you use oil in the block, use only mineral oil. Never use silicone
oil. It can damage the Alpha unit.

One exception to this recommendation involves the use of volatile radioactive 35S
nucleotides. A small amount of oil in the block can help prevent escape of these
compounds. See chapter appendix 4-B for important information regarding safe use
of these compounds in polypropylene tubes and polypropylene and polycarbonate
microplates. A second exception involves the use of thick-wall 0.5 ml tubes. Certain
brands of these tubes fit poorly in the block, in which case oil may somewhat
improve thermal contact. Whenever possible, use high-quality thin-wall tubes
intended for thermal cycling. (See chapter appendix 4-A for a tube and plate selec-
tion chart.)
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Appendix 4-A                     Tube, Microplate, and Sealing
System Selection Chart

Key

� Reaction vessel fits block/sealing option fits reaction vessel without modification.
� Reaction vessel/sealing option can be cut to fit.

* “Concord” microplates are made from polycarbonate plastic, which is prone to poor
sealing and vapor leakage during stringent thermal cycling.

** Since plates may adhere tightly to the Microseal ‘P+’ pad, this seal is only recommended
for use with the Moto Alpha™ motorized unit, which has the ability to hold the plate in the block.

Bio-Rad Thermal
Cycler Blocks

Reaction Vessels Sealing Options for Oil-Free Cycling

384 96
(0.2ml)

48
(0.2ml)

60/30
(0.5ml)

Description Bio-Rad
Catalog #

Microseal
‘A’ film

MSA-5001

Microseal
‘B’ seal

MSB-1001

Microseal
‘F’ foil

MSF-1001

Sealing
mat 

223-9442

Microseal
‘P’ pad

MSP-1001

Microseal
‘P+’ pad**
MSP-1002

Strip
caps

TCS-series

Chill-out
wax

CHO-series

� Hard-Shell® skirted
384-well microplates

HSP-series � � � � � �

� Microseal® skirted
384-well microplates

MSP-series � � � � �

� Hard-Shell skirted
96-well microplates

HSP-series � � � � � � � �

� Microseal skirted
96-well microplates

MSP-series � � � � � � �

� � MultiplateTM unskirted
96-well microplates

MLP-series
MLL-series � � � � � � �

� � Multiplate unskirted
48-well microplates

MLP-series � � � � � �

� � Multiplate unskirted
25-well microplates

MLP-2501 � � � � � �

� � Multiplate unskirted
24-well microplates

MLP-2401 � � � � � �

� ConcordTM skirted
96-well microplates*

CON-9601 � � �

� � 0.2ml strip tubes
8/strip & 12/strip

TBS-series
TLS-series � � �

� � 0.2ml individual
tubes

TFI-0201
TWI-0201
TBI-series

� � �

� 0.5ml individual
tubes, w/caps

TBI-series �
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Appendix 4-B                    Safety Warning Regarding Use of
35S Nucleotides

Some researchers have experienced a problem with radioactive contamination when
using 35S in thermal cyclers. This problem has occurred with all types of reaction vessels.

The Problem

When 35S nucleotides are thermally cycled, a volatile chemical breakdown product
forms, probably SO2. This product can escape the vessel and contaminate the
sample block of a thermal cycler, and possibly the air in the laboratory.
Contamination has been reported with microassay plates, 0.2 ml tubes, and 0.5 ml
tubes.

96-Well Polycarbonate Microplates

These microplates present the largest risk of contamination. Polycarbonate is some-
what permeable both to water and the 35S breakdown product. This problem is
exacerbated when polycarbonate plates are held at high temperatures for long
periods of time, or when the plates are sealed for oil-free thermal cycling.

0.2 ml Polypropylene Tubes and 96-Well Polypropylene Microplates

These tubes are manufactured with very thin walls to enhance thermal transfer. The
thin walls are somewhat fragile and can “craze” or develop small cracks when sub-
ject to mechanical stress. Undamaged thin polypropylene tubes may also be
somewhat permeable to the 35S breakdown product. Either way, there have been
reports of 35S passing through the walls of 0.2 ml tubes of several different brands
during thermal cycling. No data are yet available on radioactive contamination with
polypropylene microplates.

0.5 ml Polypropylene Tubes

Contamination problems are rarer with this type of tube, but instances have been
reported.

The Solution

1. Substitute the low-energy beta emitter 33P in cycle sequencing. 33P nucleotides
are not subject to the same kind of chemical breakdown as 35S nucleotides, and
they have not been associated with volatile breakdown products.

2. If 35S must be used, three things will help control contamination: an oil overlay
inside the tubes, mineral oil in the thermal cycler outside the tubes, and use of
thick-walled 0.5ml tubes. Always run 35S thermal cycling reactions in a fume
hood, and be aware that vessels may be contaminated on the outside after
thermal cycling. Please be certain that you are using the appropriate detection
methods and cleaning procedures for this isotope. Consult your radiation safety
officer for his or her recommendations.
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If mild cleaning agents do not remove radioactivity, harsher cleaners may be used.
Users have suggested the detergent PCC-54 (Pierce Chemical Co., Rockford, Illinois;
Pierce Eurochemie B.V., Holland), Micro Cleaning Solution (Cole-Parmer, Niles, Illinois),
and Dow Bathroom Cleaner (available in supermarkets).

Caution: Harsh cleaning agents are corrosive to aluminum and must
never be used on bare aluminum blocks. Bio-Rad Alpha unit
blocks are anodized, so they have a protective coating of
aluminum oxide. Still, harsh agents (such as those above)
must be thoroughly rinsed away within a few minutes of
application, or the anodization will degrade.
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Running a Protocol

Running a protocol on the DNA Engine® cycler involves three steps: 

1. Choosing a stored protocol to run.

2. Choosing a block to run it on, if a Dual Alpha™ unit is installed.

3. Setting up the temperature control method.

Either a custom-designed protocol or one of the factory-installed resident protocols
may be run. See appendix C for descriptions of the resident protocols, which may be
edited to fit your needs (see chapter 7). All the factory-installed protocols are stored
in a single folder, called the <MAIN> folder, at the time of shipping.

Choosing a Stored Protocol to Run

With the Main Menu displayed, select Run, then press «Proceed». One of two types
of screen will be displayed, depending on whether custom protocols have been
stored in the <MAIN> folder or in custom folders:  

•  If all protocols have been stored in the <MAIN> folder:

The first of three or more screens listing the protocols will be displayed. Custom protocols
are listed first, then the 14 factory-installed programs:

Use the «Select» keys to scroll through the listed protocols. Scroll past the last- or first-listed
protocol to see the next screen down or up. Select the desired protocol, then press
«Proceed».

•  If custom protocols have been stored in one or more custom folders: 

One or more screens listing all the folders residing in the machine will be displayed:

Select the folder that contains the protocol, then press «Proceed». One or more
screens listing the protocols stored in the folder will be displayed. Use the «Select»
keys to scroll through the listed protocols. Select the desired protocol, then press
«Proceed».

Run: <MAIN>
_CUSTOM1 CUSTOM2
QUIKSTEP  2-STEP
3-STEP   EXTEND

Run:
_<MAIN>   <FOLDER>
<FOLDER2> <FOLDER3>
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In either instance, after you press «Proceed», a screen similar to the following
example will be displayed:

The top line of the screen will identify the selected protocol (2-STEP in the example).
The other lines on the screen will request information needed to set up the temperature
control method (explained below). 

Choosing a Block to Run the Protocol On

If a Dual Alpha unit is installed (or if networked Alpha units are available; see chapter
9), one of the blocks must be designated to run the protocol. The first available block
is automatically designated when a protocol is chosen. Press «Block» to choose a dif-
ferent block. The selected block’s letter is identified in the upper right-hand corner of
the screen:

The status indicator light for the selected block will flash green. 

Setting Up the Temperature Control Method

When the protocol is selected (and the correct block is designated for a Dual Alpha unit),
one or more screens will be displayed. These screens will ask for information needed to
set up the block’s temperature control method. The DNA Engine cycler can control the
block’s temperature in two different ways: block control or calculated control. Chapter
6 explains in detail how these methods work and their implications for protocol design.
The following describes how to respond to the screens that are displayed for each con-
trol method. When these screens have been dealt with, the protocol will begin to run.

Setting Up a Block-Control Protocol

A single screen asking about use of the heated lid will be displayed:

Select Yes or No, then press «Proceed». The protocol will begin running.

Run: 2-STEP

Vessel Type:
_TUBES   Plate

Run: 2-STEP on A

Vessel Type:
_TUBES   Plate

Run: ICEBUCKET

Use heated lid?
Yes  _NO
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Setting Up a Calculated-Control Protocol

Three screens will be presented:

•  A screen asking for sample vessel information:

Select from the options shown (may include tubes, plates, and slides), then press
«Proceed». Choose Plate for polycarbonate microplates and Tube for polypropylene
tubes or polypropylene microplates. For blocks that hold only tubes, choose Thin or
Thick, depending on the type of tube loaded.

Note: See “Using Calculated Control” in the Slide Chambers Alpha Unit Operations
Manual for information on specifying slide format.

•  A screen asking for the sample reaction volume (last line in example below):

Use the keypad to enter a sample volume in microliters, then press «Proceed». If
sample vessels are sealed with oil or wax, include the volume of the oil or wax in the
total sample volume entered.

Note: Specify 10 µl for any volume less than 10 µl.

Note: Verify that your vessel sealing system is adequately tight before performing 5 µl
reactions.

•  A screen asking about use of the heated lid. Select Yes or No, then press
«Proceed». The protocol will begin running. 

Run: 2-STEP

Vessel Type:
_TUBES   Plate  

Run: 2-STEP

Vessel Type: TUBES
Volume (μl):  10

DNA Engine  Operations Manual
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Reading the Runtime Screen

During a protocol run, a runtime screen will be displayed:

The screen lists the protocol name (2-STEP in the example above), protocol step that
is running (1), cycle number (1), method of temperature control (Calc), and the block
temperature for block-control protocols, and the calculated sample temperature for
calculated-control protocols (68.0°). When the step’s target temperature is reached,
a timer begins running in the lower right-hand corner of the screen. The first digit is
the minutes elapsed; the two digits after the colon are the seconds elapsed.

For protocols using calculated control, press the left «Select» key to display the
block’s temperature on the third line of the screen:

This screen shows only as long as the left «Select» key is pressed. The runtime
screen returns when you stop pressing the key.

Press the right «Select» key to see a screen listing the cycle number (if a GoTo step is
executing), time elapsed so far for the protocol run, and estimated remaining time left
in the run:

This screen is also displayed only as long as the key is pressed. The runtime screen
returns when you stop pressing the key.

Run: 2-STEP
1=  92.0° for 0:05

Block: 62.1
Calc:  68.0°

Run: 2-STEP
1=  92.0° for 0:05

Cycle:  1
Calc:  68.0°

Run: 2-STEP
Cycle: 1
Total time: 0:20
Est remain: 1:01:51
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Switching Between the Runtime Screen and the Main Menu

Press «Block» to toggle between the runtime display and the Main Menu. This allows
you to edit a stored program, enter a new one, print a program, run another protocol
on a dual-block Alpha unit or networked DNA Engine cycler, or use the file utilities,
while the protocol runs.

Reading the Protocol Completion Screen 

When the protocol run finishes, a long beep sounds, and a notification screen is displayed:

Certain error messages may also be displayed in this screen (see chapter 11). Press
«Proceed» to return to the Main Menu.

Printing a Log for a Running Protocol

If the DNA Engine cycler is connected to a printer, you can print a log for the run that
includes:

• The DNA Engine cycler’s serial number and software version

• The protocol’s name

• The temperature control method for the protocol

• A list of the protocol’s steps

• The runtime thermal data

To print a runtime protocol log, first ensure that a printer is connected to the machine.
See “Printing a Program,” chapter 8, for information about compatible printers. 

Follow the instructions under “Choosing a Printer Port,” chapter 8, to prepare the
DNA Engine cycler to communicate with your printer. 

As long as a printer is connected to the machine, the following screen will appear
whenever a protocol is run:

Run: 2-STEP
PROGRAM COMPLETE

Total time: 50:31

Run: 2-STEP

Printer output?
_Yes   No



Running Protocols

Tech Support: 1-800-4BIORAD • 1-800-424-6723 • www.bio-rad.com 5-7

To print the protocol as it runs, select Yes, then press «Proceed». 

Note: If no printer is connected to the machine, the screen allowing you to select
printer output is not displayed at all.

Manually Stepping Through a Protocol

Once a protocol is running, pressing «Proceed» gives you the option of immediately
advancing the protocol to the next programmed step, even if the machine is currently
ramping the block’s temperature (see chapter 6 for information on ramping). A confirmation
screen will be displayed:

Select Yes, then press «Proceed». The protocol will advance to its next step.

Pausing a Running Protocol

Press «Pause» to temporarily stop a running program. The timer in the lower right-hand
corner of the runtime screen will be replaced by the word “Pause”:

The samples are held at the displayed temperature until either the «Pause» or the «Proceed»
key is pressed, which causes the protocol run to resume.

A protocol cannot be paused before the target temperature for a given step has been
reached. If «Pause» is pressed before this point, the block continues heating or cooling until
the target is reached, and then the protocol is paused.

Run: 2-STEP

Go on to next step?
_YES  No

Run: 2-STEP
1=  92.0° for 0:05

Cycle:  1
Calc:  92° PAUSE
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Stopping a Running Protocol

Press either «Stop» or «Cancel» to stop a running protocol. A cancellation confirmation
screen will be displayed:

Select Yes, then press «Proceed» to cancel the protocol. The total run time for the
protocol will be displayed:

Press «Proceed» to return to the Main Menu.

Note: Turning off the machine does not stop a running protocol. The DNA Engine cycler will
assume the protocol was stopped by a power outage and will resume running the protocol
when the machine is turned back on (see below). 

Resuming a Protocol after a Power Outage

If a power failure occurs when a protocol is running, the DNA Engine cycler will hold the pro-
tocol in memory for a minimum of 24 hours to a maximum of 7 days, depending on
environmental conditions.

When power is restored, the protocol will begin running again at the point at which it was
stopped, and a notice about the power interruption will be displayed. The notice will identify
the step and the cycle that were running when the power failure occurred, and the block’s
temperature at the time power was restored:

Press «Proceed» to remove this screen. The protocol’s runtime screen will immediately be
displayed.

Run: 2-STEP

Stop 2-STEP?
Yes  _NO

Run: 2-STEP
PROGRAM CANCELED

Total time: 1:15

Run: 2-STEP
A/C POWER FAILED
Cycle 1   Step 1

Recovered at 20.2°
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Using the Instant Incubation Feature

The DNA Engine cycler may be converted to a constant-temperature incubator by
pressing «Instant Incubate». A screen allowing use of the heated lid will be displayed:

Use the «Select» keys to enable or disable the heated lid, then press «Proceed». A screen
allowing entry of the incubation temperature will be displayed. 

Use the keypad to enter any incubation temperature from –5.0° C to 105.0° C, then
press «Proceed». The DNA Engine cycler will incubate the sample at the specified tem-
perature until «Cancel» or «Stop» is pressed.

When the sample block reaches the incubation temperature, a timer begins running in
the lower right-hand corner of the screen. To stop and start the timer, press «Pause». 

� Tip: The Pause feature is useful if you need to temporarily remove samples that must be
incubated for a precise period of time. Pausing the timer while samples are not in the
block allows you to track the exact duration of their incubation.

INCUBATE:

Use heated lid?
Yes  _No

INCUBATE:
1=  20.0° for ever
Use heated lid?

Yes  _No
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The Elements of a Program

DNA Engine® cycler programs consist of a series of steps encoding a protocol. These
steps are run using one of two possible temperature control methods: calculated con-
trol or block control.

Programs may contain five types of steps. Two of the steps are mandatory, and three are
optional:

1. Temperature step (mandatory): Sets a temperature for the block and the length
of time it is held at that temperature. The DNA Engine cycler brings the block to
this temperature at its maximum rate of heating or cooling, unless modifying
instructions are added to the program. (The maximum rate of heating and cooling
is up to 3°C/sec for all single- and dual-block Alpha™ units; 1.2°C/sec for the
Slide Chambers™ Alpha unit.)

2. Gradient step (optional): Allows you to program a temperature gradient across
the sample block. The range of any single gradient can be as great as 24°C from
left to right. The maximum programmable temperature is 105°C; the minimum
programmable temperature is 30°C.  

3. Ramp step (optional): Sets a slower-than-maximum rate of heating or cooling.

4. GoTo step (optional): Causes the program to cycle back to an earlier step for a
specified number of times (up to 9,999 times). 

5. End step (mandatory): Instructs the DNA Engine cycler to shut down its heat
pump because the program is complete.

Additional instructions, termed options, can be added to certain program steps to modify
their effects:

1. Increment: Modifies a temperature step to allow a progressive increase or decrease
of temperature (0.1–10.0°C per cycle) each time the step is executed in a cycle.
This is useful in “touchdown” programs, when the annealing temperature of an
oligonucleotide is not known.

2. Extend: Modifies a temperature step to allow progressive lengthening or shortening of
a temperature step hold (by 1–60 sec/cycle) each time a step is executed in a cycle.
This is useful for accommodating an enzyme with diminishing activity.

3. Beep: Modifies a temperature step or ramp step to make the machine beep when the
target temperature is reached.
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Designing a New Program

Translating a Protocol into a Program

Until you are completely familiar with programming the DNA Engine cycler, you may find
it helpful to first translate the protocol into DNA Engine cycler program steps and options
on paper. Write down the protocol to be programmed, one step per line. Then write the
type of program step that goes with the protocol steps, at the end of each line.  If a pro-
tocol step involves an option as well as a program step, write both names down on the
same line. Finally, write the End step at the bottom of the list; programs will not run
without this step. Number the lines 1 through N, where N is the final, End line.

Using the GoTo Step to Write Short Programs

The GoTo step allows programs of many repetitious steps to be shortened to just a few
lines. When the program encounters a GoTo step, it returns to a specified step, repeats
that step, and repeats all steps that follow, back to the GoTo step. When the program
has returned, or cycled, back to the step a specified number of times, the program
moves on to the step that follows the GoTo step.

For example, consider a basic cycle sequencing protocol consisting of 30 repeats of a
denaturation, and an annealing/extension step. Rather than listing all 60 steps, use a
GoTo step to design a short, easy-to-enter program:

Raw program: DNA Engine program:

1. 92° for 30 sec

2. 60° for 3 min

3. 92° for 30 sec

4. 60° for 3 min

5. 92° for 30 sec

6. 60° for 3 min

7. 92° for 30 sec

[continues for total of 60 lines]

1. 92° for 30 sec

2. 60° for 3 min

3. GoTo step 1, 29 times (i.e.,
cycle back to step 1 and repeat
steps 1 and 2, 29 times)

5. End
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Choosing a Temperature Control Method

The DNA Engine cycler can control block temperature in two possible ways, each of
which has different implications for the speed and accuracy of sample heating:

•  Calculated control: The DNA Engine cycler adjusts the block’s temperature to
maintain samples of a specific volume in a specific vessel type at programmed tem-
peratures. This includes optimized overshoots of the block by a few degrees for a few
seconds, which bring the samples to the programmed temperatures.

•   Block control: The DNA Engine cycler adjusts the block’s temperature to maintain
the block at programmed temperatures, independent of sample temperature.

Calculated Control

Calculated control is the method of choice for most types of programs, yielding the most
consistent, most reliable, and fastest programs. When using calculated control, the
DNA Engine cycler maintains a running estimate of sample temperatures based on the
block’s thermal profile, the rate of heat transfer through the sample tube or slide, and the
sample volume or mass (this information about the samples is provided when a program
is run; see “Setting Up the Temperature Control Method,” chapter 5). Since this estimate
is based on known quantities and the laws of thermodynamics, sample temperatures
are controlled much more accurately than with block or probe control.

Hold times can be shortened significantly when protocols are run under calculated
control. In addition to the simple convenience of spending less time running reactions,
shorter protocols also help preserve enzyme activity and minimize false priming.
Cycling denaturations run under calculated control are usually optimal at 5 seconds.
Annealing/extension steps can also be shortened, but the periods for these will be
reaction specific. 

Calculated control provides for shorter protocols in three ways: 

1. Brief and precise block temperature overshoots are used to bring samples to 
temperature rapidly.

2. Incubation periods are timed according to how long the samples, not the 
block, reside at the target temperature.

3. The machine automatically compensates for vessel type and reaction volume. 

Block Control

Block control provides less accurate control of sample temperatures than calculated
control provides. Under block control, the temperature of samples always lags behind
the temperature of the block. The length of the time lag depends on the vessel type and
sample volume but typically is between 10 and 30 seconds. Block control is chiefly
used to run protocols developed for other thermal cyclers that use block control. 
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Modifying Block-Control Programs for Calculated Control

Block-control programs can be changed to calculated control by subtracting at least
15–20 seconds from each temperature step. Some empirical testing may be required to
adjust modified programs for optimum performance.

Modifying a Program Designed for a Different Machine

The ramp programming step can be used to adapt programs designed for thermal
cyclers with slower maximum heating and cooling rates than the DNA Engine cycler. In
addition, a given protocol will occasionally work better with a slower rate of temperature
change; the ramp step can be used to optimize the program for such a protocol.

Entering a New Program

Programming the DNA Engine cycler moves through five steps:

1. Initiating the program

2. Naming the program

3. Choosing a temperature control method

4. Entering the program’s steps

5. Entering the End step

Each step involves entering values from the keyboard or making selections from a menu.
Programs may be edited as they are being entered.

Programs are automatically saved when the End step is entered. They are stored in the
<MAIN> folder unless folders have been created for them.

Initiating the Program

To initiate a new program, select Enter from the Main Menu, then press «Proceed». A
naming screen will be displayed:  

Enter:

Name: A
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Naming the Program

Name the program an eight-character word consisting of any combination of letters
(Roman and Greek), numbers, punctuation marks, or Japanese Katakana. 

Press the right «Select» key to scroll forward and the left «Select» key to scroll backward
through the alphabets and characters available, which are presented in this order: Roman
alphabet, selected Greek letters, punctuation marks, numbers. To access the Japanese
Katakana syllabary, press the «.» key. A second press of «.» returns the machine to
Western characters.

When the character needed is displayed next to Name, press «Proceed». The character
will be accepted, and the cursor will move one space to the right. Numbers and dashes
may also be inserted by pressing the corresponding keys on the keypad.

When the name is complete, press «Proceed» once to accept the last character and again
to accept the whole name. If the name is already in use for a program, a screen saying
“Name In Use” will be displayed. If this happens, press «Proceed», then enter a different
name.

Choosing a Temperature Control Method

When the name has been entered (“CUSTOM1” is used in the following and all succeeding
examples), a screen requesting selection of a temperature control method will be displayed:

Select a control method, then press «Proceed». 

Entering the Program’s Steps

When a temperature control method has been chosen, the Enter Menu will be dis-
played:

Enter:  CUSTOM1
Control method:

Block   Probe
_CALCULATED

Enter:  CUSTOM1
Step 1= _TEMP

Gradient
Ramp  End
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Use this menu to enter each step of the program:

•     Temp enters a temperature step.

•     Gradient enters a Gradient step.

•     GoTo enters a GoTo step (note: since a protocol cannot begin with a GoTo
step, GoTo does not appear on the initial Enter Menu).

•     Ramp enters a ramp step.

•     End enters the End step.

Entering a Temperature Step

To enter a temperature step, select Temp from the Enter Menu, then press «Proceed».
The first Temp screen will be displayed:

The second line of this screen shows the number of the step being programmed (1 is used
in the example above). The last line of the screen allows a target temperature (in degrees
Celsius) to be entered for the step.

Use the keyboard to enter any number between –5.0 and 105.0 as the target temperature
(92.0 is used in the example below):

Press «Proceed». The target temperature will move to the second line of the screen, and
a line allowing a hold time to be entered for the step will be displayed:

Enter:  CUSTOM1
1=

Temp °C: _

Enter:  CUSTOM1
1=

Temp °C: 92.0

Enter:  CUSTOM1
1= 92.0°

Time: _
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Enter the hold time for the step (30 seconds is used in the example below):

Note: If a hold time of zero (0) is entered, the DNA Engine cycler will hold the block
atthe target temperature indefinitely. 

Press «Proceed». The hold time will move to the second line of the screen, and a con-
firmation menu will be displayed on the last line:

Select one of the displayed choices, then press «Proceed»: 

•    Yes accepts the step and displays the Enter Menu again. Use the Enter
Menu to enter the next step in the program.

•    No allows reentry of the target temperature and hold time for the step.

•   Option displays the Options Menu (see “Modifying a Program Step with
the Options,” p. 6-15). 

� Tip: Avoid programming many short holds of only a few seconds each. This can overheat
the block, causing the “HS Overheating” or “PS Overheating” error messages to be
displayed and triggering automatic Alpha unit shutdowns if the block exceeds its maximum
allowable temperature.  

Entering a Gradient Step

When you reach the step at which a gradient is desired, select Gradient from the
Enter Menu and then press the «Proceed» key.  For the purpose of this example the
step in which the gradient will be entered shall be Step 2: 

Enter:  CUSTOM1
1= 92.0°

Time: 30

Enter:  CUSTOM1
1= 92.0° for 0:30

OK?: _YES No Option

Enter:  CUSTOM1
Step 2= Temp Goto

_GRADIENT
Ramp  End
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The gradient screen will appear:

Enter the lower limit temperature (for the purposes of this example, 50°), then press
«Proceed».  The upper temperature screen will appear:

Enter the upper temperature (for the purposes of this example, 70°), then press «Proceed».
(Use integers only; decimals are not accepted).

The next screen requires you to enter a hold time for the temperature gradient step:

Enter the hold time in the form of min:sec.  Press «Proceed».  A confirmation screen
will appear:

Select “Yes” to enter the step into memory and proceed to the next step; select “No” to
reject or edit the current step.  To preview, select Option, then Preview.  Preview gives the
predicted temperatures for each of the wells along the sample block’s long axis.  (The lines
do not all appear in the display; use the «Select» keys to scroll up or down.)

Enter:  CUSTOM1

Lower Temp °C:

Enter:  CUSTOM1
50.0°

Upper Temp °C:

Enter:  CUSTOM1
2= 50.0° to 70.0°

Time:

Enter:  CUSTOM1

2= 50.0° to 70.0°
for 0:30
OK? Yes No Option

Gradient Preview:
Column 1- 50.0° left
Column 2- 51.8°
Column 3- 53.6°
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Editing a Gradient Step

To edit a gradient step, select Edit from the Main Menu.  The program will be displayed
as follows:

Use the «Select» keys to scroll to the step you want to edit.  

Reviewing a Gradient Program

After the protocol has been run, the Program Complete screen will be displayed.  Press the
«Proceed» key, and the next screen will display a review of the gradient well temperatures:

Gradient Review:

Column 1-  50.0° left

Column 2-  50.5°

Column 3-  51.5°

Column 4-  53.2°

Column 5-  55.5°

Column 6-  58.4°

Column 7-  61.8°

Column 8-  64.6°

Column 9-  66.8°

Column 10- 68.4°

Column 11- 69.6°

Column 12- 70.0° right

Scroll up and down the screen using the «Select» keys. When scrolling the “Gradient
Review” line will be held constant while the lower 3 lines can be manipulated up or down.
The temperatures displayed will be for each of the twelve wells along the long-axis of the
sample block. These temperatures will be predicted from an algorithm as a steady-state
temperature of the block and the sample. You may then return to the Main Menu by
pressing the «Proceed» key.

List: CUSTOM1
1= 92.0° for 0:20
2= 50.0° to 70.0°

for 0:30
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Using the Gradient Calculator 

The gradient calculator predicts, for a given gradient, the temperatures for each of
the twelve wells along the long-axis of the sample block. These temperatures will be
predicted from an algorithm as a steady-state temperature of the block and the
sample. To use the gradient calculator, select the List command from the Main Menu
and then press the «Proceed» key. You will see a List screen:

Select Gradient Calculator  and press the «Proceed» key :

Enter lower limit temperature of the gradient using the number keys and then press
the «Proceed» key. Enter the upper temperature for the gradient using the number
keys and «Proceed» key. You may enter integers without decimal points. The following
screen will be displayed:

Gradient Calculator: 

Column 1-  50.0° left 

Column 2-  50.5°

Column 3-  51.5°

Column 4-  53.2°

Column 5-  55.5°

Column 6-  58.4°

Column 7-  61.8°

Column 8-  64.6°

Column 9-  66.8°

Column 10- 68.4°

Column 11- 69.6°

Column 12- 70.0° right

You may scroll up and down the screen using the «Select» keys. When scrolling, the
“Gradient Calculator” line will be held constant while the lower 3 lines can be manipulated
up or down.  

List: 
Programs
_GRADIENT CALCULATOR

Lower Temp °C: 50.0°
Upper Temp °C: 70.0°
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Entering a Ramp Step

To enter a ramp step, select Ramp from the Enter Menu. The first Ramp screen will
be displayed:

The second line of this screen shows the number of the step being programmed (3
is used in the example above). The last line of the screen allows a ramp rate (in
degrees Celsius per second) to be entered for the step.

Use the keyboard to enter any rate up to 2.5°C/sec (1°C/sec is used in the example below):

Note: If a ramp rate faster than the Alpha unit’s maximum rate of heating and
cooling is entered, the maximum rate will be used. 

Press «Proceed». The ramp rate will move to the second line of the screen, and a line
allowing entry of a finish temperature for the ramp step will be displayed:

Enter the finish temperature for the ramp step (69°C is used in the example below):

Press «Proceed». The finish temperature will be moved to the second line of the
screen, and a confirmation menu will be displayed on the last line: 

Enter: CUSTOM1
3= 

Rate °C / s: _

Enter: CUSTOM1
3= 

Rate °C / s: 1

Enter: CUSTOM1
3= 2.0°/s

Finish temp:    _

Enter: CUSTOM1
3= 2.0°/s

Finish temp:   69

Enter: CUSTOM1
3= 2.0°/s to 60.0°

OK? _YES  No  Option
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Select one of the displayed choices, then press «Proceed»: 

•     Yes accepts the step and displays the Enter Menu again. Use the Enter Menu to
enter the next step in the program. 

•     No allows reentry of the ramp rate and finish temperature. 

•    Option displays the Options Menu (see “Modifying a Program Step with the   Options,”
p. 6-11).

� Tip: A ramp step will not hold the block at its finish temperature. Instead, as soon as finish
temperature is reached, the next step of the program will immediately be executed. To
hold the block for some period of time at a ramp step’s finish temperature, make sure a
temperature step immediately follows the ramp step, and program the hold at the finish
temperature into this step.

Entering a GoTo Step

To enter a GoTo step, select GoTo from the Enter Menu. The first GoTo screen will be
displayed:

The second line of this screen shows the number of the step being programmed (5 is used
in the example above). The last line of the screen allows entry of the number of the step
the program should cycle back to.

Enter the number of the step the program should cycle back to (1 is used in the
example below):

Press «Proceed». The step number will move to the second line of the screen, and a
line allowing an additional number of cycles to be entered will be displayed:

Enter: CUSTOM1
5=GoTo 

GoTo step: _

Enter: CUSTOM1
5=GoTo 

GoTo step: 1

Enter: CUSTOM1
3=GoTo 1 

Addtnl cycles:    _ 
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Enter the additional number of times the program should cycle back to the step (3 is
used in the example below):

Press «Proceed». The number of additional cycles will move to the second line of the
screen, and a confirmation menu will be displayed on the last line:

Select one of the displayed choices, then press «Proceed»: 

•    Yes accepts the step and displays the Enter Menu again. Use the Enter Menu to
enter the next step in the program.

•    No allows reentry of the step number and number of additional cycles.

Entering the End Step

To enter the End step, select End from the Enter Menu. The single End screen will be
displayed:

This screen automatically enters “End” on the second line of the screen, next to a step
number, and displays a confirmation menu for the step on the last line of the screen.

Select one of the displayed choices, then press «Proceed»: 

•     Yes accepts the step, stores the program, and displays the Main Menu.

•     No displays the Enter Menu so that additional steps can be added.

Enter: CUSTOM1
3=GoTo 1 

Addtnl cycles:    3

Enter: CUSTOM1
3=GoTo 1, 3 times 

OK? _YES  No 

Enter: CUSTOM1
4=End 

OK? _YES  No
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If you have created custom folders for your programs (see chapter 8), choosing Yes
brings up a screen listing the folders:

Select the folder you want to store the program in, then press «Proceed». The pro-
gram will be stored in the folder, and the Main Menu will be displayed. 

Modifying a Program Step with the Options

The Options Menu is accessible from the confirmation menus of temperature steps
and ramp steps. To access the Options Menu, select Option from the confirmation
menu of a temperature or ramp step, then press «Proceed». The Options Menu will
be displayed on the bottom line of the screen: 

•    Inc modifies a temperature step with an increment option. An increment option
allows a progressive increase or decrease of temperature each time the step is
executed in a GoTo cycle. 

•  Ext modifies a temperature step with an extend option. An extend option
allows a progressive lengthening or shortening of hold times each time the step
is executed in a GoTo cycle. 

•    Beep modifies a temperature step or a ramp step, causing the machine to
beep when a specified target temperature is reached.

Entering an Increment Option

To enter an increment option, select Inc from the Options Menu for a temperature
step, then press «Proceed». The first Inc screen will be displayed:

Save Program in:
<MAIN>   <FOLDER>
<FOLDER2>

Enter: CUSTOM1
1= 92.0° for 0:30

Option:_INC Ext Beep

Enter: CUSTOM1
1= 92.0° for 0:30

+
°C / cycle: + _
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The temperature step being modified appears on the second line of this screen. The plus
sign on the third line means that the screen is set up to enter a progressive increase in
temperature per cycle. Press «–» to switch to a minus sign, allowing entry of a progressive
decrease in temperature. Press «Cancel» to change back to a plus sign.

Enter the numerical value of the temperature increase or decrease (1.2 is used in the
example below):

Press «Proceed». The Inc value just entered will move to the third line of the screen,
and a confirmation menu will be displayed on the last line:

Select one of the displayed choices, then press «Proceed»:

•   Yes accepts the Inc value and displays the Enter Menu again. Use the Enter
Menu to enter the next step in the program.  

•   No allows reentry of the Inc value. 

•   Option displays the Options Menu again. Use the Options Menu to enter another
option for the step.

Entering an Extend Option

To enter an extend option, select Ext from the Options Menu of a temperature step,
then press «Proceed». The first Ext screen will be displayed:

As for Inc, the temperature step being modified appears on the second line of this
screen. The plus sign on the third line means that the screen is set up to enter progressive
lengthening of hold time. Press «–» to switch to a minus sign, allowing entry of a
progressive shortening of hold time. Press «Cancel» to change back to a plus sign.

Enter: CUSTOM1
1= 92.0° for 0:30

+
°C / cycle: + 1.2

Enter: CUSTOM1
1= 92.0° for 0:30

+ 1.2° per cycle
OK? _YES  No  Option

Enter: CUSTOM1
1= 92.0° for 0:30

+
Sec / cycle:  + _
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Enter the numerical value of the increase or decrease in hold time (1.0 is used in the
example below):

Press «Proceed». The Ext value just entered will move to the third line of the screen, and
a confirmation menu will be displayed on the last line:

Select one of the displayed choices, then press «Proceed»:

•   Yes accepts the Ext value and displays the Enter Menu again. Use the Enter
Menu to enter the next step in the program.  

•   No allows reentry of the Ext value. 

•   Option displays the Options Menu again. Use the Options Menu to enter
another option for the step.

Entering a Beep Option

To enter a beep, select Beep from the Options Menu for a temperature step or a ramp
step, then press «Proceed». The word “Beep” will be displayed on the third line of the
screen, and a confirmation menu will be displayed on the last line:

Select one of the displayed choices, then press «Proceed»:

•   Yes accepts the Beep option and displays the Enter Menu again. Use the
Enter Menu to enter the next step in the program. 

•   No cancels the Beep option.  

•   Option displays the Options Menu again, if a temperature step is being modified.
Use the Options Menu to enter another option for the step. (Option will not be
displayed if a ramp step is being modified, since Beep is the only option available
for ramp steps.)

Enter: CUSTOM1
1= 92.0° for 0:30

+
Sec / cycle:  + 1

Enter: CUSTOM1
1= 92.0° for 0:30

+ 1 sec / cycle
OK? _YES  No  Option

Enter: CUSTOM1
1= 92.0° for 0:30

Beep
OK? _YES  No  Option
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Revising During Programming

To change values in a program you are entering, follow the procedures described below.
This editing method should be used to change just a few values at a time. To make many
changes, or to delete or add entire steps, use Edit mode (see chapter 7).

To Change the Last Value Entered or Menu Option Chosen

Press «Cancel». The choice just made will be cancelled, so that another value may be
entered or another menu option chosen. Press «Proceed» after changing a value, so that
the program will accept it.

To Change All the Values in the Step Being Entered

Repeatedly press «Cancel». Each time you press the key, the cursor will move backward
through the values for the step, deleting the values as it moves. When all values for the
step have been deleted, enter new values, or press «Cancel» one more time to display
the Enter Menu for the step. At this point you can change the step to a different type.

To Change Values for Earlier Steps in the Program

Repeatedly press «Cancel» until the Enter Menu for the step you are working on is displayed.
Press «Cancel» one more time to display a list of all steps entered so far. The list will
show the step number and the values for each step, including any options chosen. The
last-entered steps will be displayed first:

At this point, you can choose to change selected values in program steps, to add an
option, to enter Edit mode, or to delete the entire program. 

Press the «Select» keys to scroll through the program. The left «Select» key moves the
cursor backward through the steps, and the right «Select» key moves it forward.

•    To change selected values or add an option: To change a value, move the
cursor to it, then press «Cancel». Enter the new value, then press «Proceed». If you
change your mind, press «Cancel» again; the deleted value will be restored. 

Enter: CUSTOM1
3= 55.0° for 0:30
4= 72.0° for 1:00
5=
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To add an option to a step, move the cursor to the step number, then press
«Proceed». The Edit Menu will be displayed:

Select Option, then press «Proceed», and follow the procedure for adding an option.
To abandon the Edit Menu and return to the list of program steps, press «Cancel».

•    To enter Edit mode: Move the cursor to the number of the step you wish to
edit, then press «Proceed». See chapter 7 for information on entering Edit
mode. If you do not wish to enter Edit mode, press «Cancel». The screen will
return to the list of program steps.

•   To delete the program: Position the cursor on any step number and press
«Cancel». A cancellation confirmation screen will be displayed. 

Select Yes, then press «Proceed». The program will be deleted, and the Main Menu
will be displayed.

Deleting a Program

To delete a program after at least one complete step has been entered, see “Revising
During Programming,” (p. 6-18).

To delete a program before one complete step has been entered, repeatedly press
«Cancel». The cursor will move backward through the step’s values, deleting them as
it goes. When all values have been deleted, keep pressing «Cancel» to move backward
through Enter mode screens until the Main Menu reappears, at which point you can
begin a new program.

Keeping a Permanent Record of Programs

Occasionally in the course of repairing a defective DNA Engine cycler, it is necessary
to replace the chip that stores all custom user protocols. To avoid losing your protocols
in such an event, always maintain an up-to-date record of them. Protocols may be
printed out using the List utility (see chapter 8), stored on a computer using the
Easy Engine™ software, or written down in a notebook.

Enter: CUSTOM1
2=  92.0° for 0:40

_Edit  Insert
Step: Option Delete

Enter: CUSTOM1

Cancel program?
_YES  NO
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Editing a Stored Program

The DNA Engine® cycler’s editing tools, available through Edit on the Main Menu,
make it easy to extensively edit stored programs by:

•     Changing individual values in program steps

•     Adding new steps

•     Deleting steps

•     Adding options to temperature and ramp steps.

Note: The editing tools do not include a renaming function. To rename a program,
see “Renaming a Program,” chapter 8.

Initiating Editing

To initiate editing, select Edit from the Main Menu, then press «Proceed». One of two
types of screen will be displayed, depending on whether your programs have been stored
in the <MAIN> folder or in custom folders.

•     If all programs have been stored in <MAIN>:  

The screen will list the contents of <MAIN>:

Select the program to be edited, then press «Proceed». 

•     If programs have been stored in custom folders: 

The screen will list all the folders residing in the machine:

Select the folder containing the program, then press «Proceed». A list of all programs in
the folder will be displayed. Select the program to be edited (CUSTOM1 is used in the
following and all succeeding examples in this chapter), then press «Proceed». 

In either instance, after you press «Proceed», the first editing screen will be displayed.

� Tip: To retain the original version of a program, copy the program (see “Copying a Program,”
chapter 8), and then edit the copy.

Edit:     <MAIN>
_CUSTOM1  CUSTOM2 
CUSTOM3  QUIKSTEP
2-STEP   3-STEP

Edit:  
_<MAIN>  <FOLDER1>
<FOLDER2>
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Editing the Program

The first editing screen displays the two temperature control methods. The program’s
current temperature control method is displayed in all-capital letters:

Select a different temperature control method if desired, then press «Proceed» The
first three lines of the program will be displayed:

Use the «Select» keys to scroll up and down through the program. The cursor will
progressively move to the step number and the individual values for each step. 

To change an individual value in a step, position the cursor on it and type the new value,
then press «Proceed». The new value will be displayed on the screen. To cancel a
change, press «Cancel». The original value will be restored.

To add or delete a step, or to modify a step with an option, position the cursor on the step
number, then press «Proceed». The Edit Menu will be displayed for that step:

•   Edit displays the previous screen again, but with the cursor positioned on the first
value for the step, so that it may be changed. 

•   Insert allows a step to be added before the displayed step.

•   Delete deletes the displayed step. 

•   Option allows an option to be added to the displayed step if it is a temperature
or a ramp step.

Enter: CUSTOM1
Control method:

Block
_CALCULATED

Edit: CUSTOM1
_1= 92.0° for 0:10
2= 63.0° for 1:00
3=GoTo 1, 24 times

Edit: CUSTOM1
2= 63.0° for 1:00

_EDIT   Insert
Step: Option Delete
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Inserting a New Step

To insert a new step, select Insert from the Edit Menu, then press «Proceed». The Enter
Menu will be displayed for the new step (a new step 2 is added in the example below):

Use the Enter Menu to create the new step (see “Entering the Program’s Steps,” chapter 6).
When the step is complete, select Yes from the confirmation menu, then press «Proceed».
The program being edited will be displayed again, with the new step appearing among the
listed steps.

Deleting a Step

To delete a step, select Delete from the Edit Menu, then press «Proceed». The step will
immediately be deleted, and the program being edited will be displayed again, minus
the deleted step.

To cancel a deletion, see “Cancelling Editing Changes,” p. 7-5.

Note: Be careful when using Delete. Once a step has been deleted, it cannot be recovered
without abandoning all editing changes that have been made in the program. This could be
inconvenient if the program has been extensively edited.

Adding an Option

To add an option to a step, select Option from the Edit Menu, then press «Proceed». The
option menu will be displayed for the step. Add the desired option to the step (see
“Modifying a Program Step with the Options,” chapter 6). When the option is complete,
select Yes from the confirmation menu, then press «Proceed». The steps of the program
being edited will be displayed again, with the new option appearing in the list.

Saving an Edited Program

To save an edited program, use the right «Select» key to scroll to the End step of the
program. Position the cursor on the number for the step, then press «Proceed». A line
allowing the editing session to be ended will be displayed on the last line of the screen:

Edit: CUSTOM1

Step 2= _TEMP  GoTo
Ramp  End

Edit: CUSTOM1
2=End

Step:  _END Insert
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•   End saves the changes and displays the Main Menu. This ends the editing session.

•   Insert allows another step to be added just before the End step.

Cancelling Editing Changes

To cancel all editing changes made to a program, use the «Select» keys to move the
cursor to any step number, then press «Cancel». A cancellation confirmation screen
will be displayed:

Select Yes, then press «Proceed». All editing changes will be abandoned, and the
Main Menu will be displayed.

Edit: CUSTOM1

Cancel changes?
_YES  No
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Locating a Stored Program

Many of the DNA Engine® cycler’s utilities require you to locate a program stored in
the machine. The actions necessary to do this depend on whether your programs
have been stored in the <MAIN> folder or in custom folders.

•   If all programs have been stored in <MAIN>:  

The screen will list all the programs that <MAIN> contains:

Select the desired program from this list.

•   If programs have been stored in custom folders: 

The screen will list all the folders residing in the machine:

Select the folder containing the program, then press «Proceed». A list of all programs
in the folder will be displayed. Select the desired program, then press «Proceed».

File Utilities

Use these utilities, available from the Files Menu, to accomplish the following tasks:

•   Create folders to store programs in

•   Assign passwords to folders

•   Copy, delete, rename, or move programs 

To display the Files Menu, select Files from the Main Menu, then press «Proceed»:

Copy:  <MAIN>
_CUSTOM1  CUSTOM2
QUIKSTEP 2-STEP   
3-STEP   EXTEND

Copy:  
<MAIN>    <FOLDER1>
<FOLDER2> <FOLDER3>

Files: 
_COPY Delete
Move Rename
Folder Secure
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Creating a Folder

The DNA Engine cycler’s memory can hold up to 11 folders, including the <MAIN> folder.
New programs are placed in the <MAIN> folder by default unless a different folder is
specified.

To create a folder, select Folder from the Files Menu, then press «Proceed». A naming
screen will be displayed:

Name the folder, using the instructions found under “Naming the Program” in chapter
6, then press «Proceed». The name will be assigned to the new folder, the folder will
be stored, and the Main Menu will be displayed.

Assigning a Password to a Folder

Protocols in a password-protected folder cannot be edited, renamed, or deleted, nor
can new protocols be placed in the folder without the password. Users without
knowledge of the password can still run, copy, and view a program.

Note: A password cannot be assigned to the <MAIN> folder.

To assign a password to a folder, select Secure from the Files Menu, then press
«Proceed». A list of all folders in the machine will be displayed. Select the desired
folder (other than <MAIN>), then press «Proceed». The password assignment screen
will be displayed:

Valid passwords consist of numbers up to four digits long. For passwords of three digits
or less, press «Proceed» after the password has been entered. Passwords four digits long
will be automatically accepted as soon as typed, and the Main Menu will be displayed.

Passwords can be changed at any time. Follow the steps described above to select
the desired folder, then press «Proceed». A screen asking for the old password will
be displayed:

Enter the old password, then press «Proceed». The password assignment screen will
be displayed. Enter the new password, then press «Proceed». The new password will
be assigned to the folder, and the Main Menu will be displayed again.

New Folder:  

Name:  A

Secure:  <FOLDER1>

New password:  _

Secure:  <FOLDER1>

Old password:  _
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Deleting a Folder

A  folder must be empty before it can be deleted. After all programs have been
moved or deleted from the folder, select Delete from the Files Menu, then press
«Proceed». A list of all folders in the machine will be displayed. Select the folder to
be deleted, then press «Proceed». A confirmation screen will be displayed:

Select Yes, then press «Proceed». The folder will be deleted, and the Main Menu will
be displayed.

To cancel the deletion, press «Cancel», or select No and press «Proceed».

Copying a Program

The copy utility copies a program and gives the copy a new name. Copies can be
placed in the original folder or a new one. 

To copy a program, select Copy from the Files Menu, then press «Proceed». Locate
the program to be copied (see “Locating a Stored Program,” p. 8-2), then press
«Proceed». If more than one folder of programs is present in the machine, a screen
allowing you to specify the folder the program will be copied to will be displayed:

Select a folder to copy the program to, then press «Proceed». A naming screen will
be displayed:

Name the copied program (see “Naming the Program,” chapter 6), then press
«Proceed». The program will be copied to the specified folder under the new name,
and the Main Menu will be displayed.

Delete:  <FOLDER1>

Delete empty folder?
_YES    No

Copy CUSTOM1 to:
_<FOLDER1> <FOLDER2>
<FOLDER3>

Copy CUSTOM1 to:

New name: A
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Renaming a Program

To rename a program, select Rename from the File Menu, then press «Proceed».
Locate the program to be renamed (see “Locating a Stored Program,” p. 8-2), then
press «Proceed». A naming screen will be displayed:

Name the new program (see “Naming the Program,” chapter 6), then press «Proceed».
The program will be renamed and stored, and the Main Menu will be displayed.

Moving a Program

To move a program, select Move from the Files Menu, then press «Proceed». Locate
the program to be moved (see “Locating a Stored Program,” p. 8-2), then press
«Proceed». A screen listing all folders will be displayed. Select the folder the program
should be moved to, then press «Proceed». The program will be moved to the new
folder, and the Main Menu will be displayed.

Deleting a Program

To delete a program, select Delete from the Files Menu, then press «Proceed».
Locate the program to be deleted (see “Locating a Stored Program,” p. 8-2), then
press «Proceed». A confirmation screen will be displayed:

Select Yes, then press «Proceed». The program will be deleted, and the Main Menu
will be displayed.

To cancel the deletion, press «Cancel», or select No and press «Proceed».

List Utilities

Use these utilities, available under List, to accomplish the following task:

•   View and print program steps

Rename:  CUSTOM1

New name: A

Delete:  CUSTOM3

Delete program?
_YES   No
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Viewing a Program in the LCD Window

To view a program in the LCD window, select List from the Main Menu, then press
«Proceed». Locate the program to be viewed (see “Locating a Stored Program,” p.
8-2), then press «Proceed». What happens next depends on whether a printer is con-
nected to the DNA Engine cycler.

•   If a printer is connected: 

A screen will be displayed asking whether the program should be sent to the printer:

Select No, then press «Proceed». The program will be listed in the LCD window. The
first listed screen will show the program’s control method. Press «Proceed» to view
subsequent screens listing each program step, including any options. Use the
«Select» keys to scroll up or down through the steps one line at a time. To return to
the Main Menu, press «Cancel» at any time, or press either the right «Select» key or
«Proceed» when the last step appears on the screen.

•   If a printer is not connected:

The program will immediately be listed in the LCD window. You will not be given the
option of printing at all.

Note: Listed programs cannot be edited. To edit programs, select Edit from the Main
Menu (see chapter 7).

Printing a Program

First ensure that the DNA Engine cycler is connected to a printer. If no printer is con-
nected, you will not be given the option of printing at all. The DNA Engine cycler’s
parallel interface is compatible with most serial and laser printers, the Epson LX-810
dot-matrix printer parallel interface, and dot-matrix printers using interfaces similar to
the Epson’s. Use a standard DB-25/Centronics parallel interface cable to connect the
DNA Engine cycler’s parallel port to the printer’s parallel port. A null-modem serial
cable will usually be required to connect the DNA Engine cycler’s serial port to a
printer’s serial port. 

Use the Setup utilities to choose a printer port for the DNA Engine cycler (see
“Choosing a Printer Port,” p. 8-8).

Select List from the Main Menu, then press «Proceed». Locate the program to be
printed (see “Locating a Stored Program,” p. 8-2), then press «Proceed». The screen
asking whether the program should be sent to the printer will be displayed (see
above). Select Yes, then press «Proceed». The program will be printed.

List:  CUSTOM1

Printer output?
Yes   _NO
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Setup Utilities

Use these utilities, available from the Setup Menu, to accomplish the following tasks: 

•   Choose a remote port and a printer port

•   Choose a temperature control method for the Hot Bonnet heated lid

•   Look up the DNA Engine cycler’s software version number 

To display the Setup Menu, select Setup from the Main Menu, then press «Proceed»:

Choosing a Remote Port

To choose either the serial port or the IEEE-488 port, select Remote from the Setup
Menu, then press «Proceed». The port selection screen will be displayed:

The cursor will be positioned at the port currently in use. 

To choose the serial port, select Serial, then press «Proceed».  The cursor will move
to Serial, and a line allowing a baud rate to be specified will be displayed on the last
line of the screen: 

Select a baud rate, then press «Proceed». The remote port assignment will change
to serial, and the Main Menu will be displayed.

To choose the IEEE-488 port, select IEEE-488, then press «Proceed». The cursor will
move to IEEE-488, and a line allowing the DNA Engine cycler to be assigned an IEEE-
488 address will be displayed on the last line of the screen:

Setup:
_REMOTE Printer
Lid Version

Remote:
Serial _IEEE-488

Printer:
_SERIAL IEEE-488

Baud: 9600 2400_1200

Printer:
Serial _IEEE-488

Address (0-30): 0
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The instrument’s current address will be displayed. To change it, enter a number from
0–30, then press «Proceed».  The remote port assignment will change to IEEE-488,
the address number will be assigned to the instrument, and the Main Menu will be
displayed.

Note: Do not choose 0 for the machine address unless the DNA Engine cycler will be
a controller in a network (see chapter 9).

Choosing a Printer Port

To choose a printer port, select Printer from the Setup Menu, then press «Proceed».
The port selection screen will be displayed:

Select the desired port, then press «Proceed». If serial was chosen, specify the
printer’s baud rate as for “Choosing a Remote Port” (p. 8-7). 

Choosing a Minimum Block Temperature for the Hot Bonnet Lid

To set a minimum block temperature below which the Hot Bonnet lid will automati-
cally turn off, select Lid from the Setup Menu, then press «Proceed». The following
screen will be displayed:

Select «MINIMUM» and press «Proceed».  The following screen will be displayed:

Use the keypad to enter the temperature, then press «Proceed» to enter the value
and return to the Main Menu.

Choosing a Temperature Control Mode for the Hot Bonnet Lid

Two temperature control modes are available for the Hot Bonnet lid:

•  Tracking: Offsets the temperature of the heated inner lid at least a specified
number of degrees Celsius in comparison to the temperature of the sample block.

Printer:
Parallel _SERIAL

Lid: 

Mode _MINIMUM

Lid Minimum:

Turn off heated
lid below: 23°C
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•   Constant: Keeps the inner lid at a specified temperature (°C).

The DNA Engine cycler is set for the tracking mode at the factory, using an offset of
5°C, which should be adequate for most reactions. The constant mode is provided for
unusual reactions requiring the inner lid to be hot at all times. When using the constant
mode, specify a lid temperature at least 10°C higher than any temperature used in the
protocol; we suggest 105°C.

To choose a control mode, select Lid from the Setup Menu, then press «Proceed».
The following screen will appear:

Select «Mode», then press «Proceed» (to select a minimum block  temperature, see
“Choosing a Minimum Block Temperature for the Hot Bonnet Lid” above).  

The mode currently in use will be selected in the screen; select a different control
mode if desired, then press «Proceed» to enter the mode and return to the main menu.

If the tracking mode is chosen, a lid offset (up to 45°C above the block, but not to
exceed 110°C) must be specified. A line for this will appear at the bottom of the
screen: “Lid offset °C: 15.” If the constant mode is chosen, a lid target temperature
(up to 110°C) must be specified. A line for this will appear at the bottom of the screen:
“Lid target °C:   _.” In either case, enter a number, then press «Proceed».  The
tracking control mode will be implemented, and the Main Menu will be displayed. 

Determining the Software Version Number

At times it is necessary to determine the version number of the software installed in the
DNA Engine cycler (e.g., to report a problem to Bio-Rad). To do this, select Version from
the Setup Menu, then press «Proceed». The current version number will be displayed:

The top line reports the software version number (1.1L in the example). The other
two lines refer to the four “pages” that the software has been broken into and their
associated versions (L in the example).

Bio-Rad periodically updates the DNA Engine cyler software to incorporate new fea-
tures or allow new Alpha™ units to be used. Most upgrades are available free of
charge for units under warranty and may be installed into a DNA Engine cycler elec-
tronically from a desktop computer. Contact your Bio-Rad sales representative or an
authorized distributor for details. Occasionally upgrades may require a hardware
change. These upgrades require return of the DNA Engine base to Bio-Rad or an
authorized distributor.

Lid: 

_MODE Minimum

Version:  1.1L

CTRL L EXEC L
USER L COMM L
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Overview of Networking

Up to 15 instruments consisting of any combination of DNA Engine® (or
DNA Engine Tetrad®) cyclers may be networked, with or without a computer as the
controller. When networking with a computer, all the instruments are controlled from
the computer’s keyboard. When networking without a computer, a specially desig-
nated DNA Engine cycler controls the other instruments in the network. Any
combination of single- and dual-block Alpha™ units may be loaded into networked
instruments, and different protocols can be run independently on them.

Networked instruments can help save time for a busy laboratory. For example, in a
DNA Engine cycler–controlled network, protocols can be entered into the controlling
instrument and then be run on all the other instruments connected to the network. 

Networking Instruments without a Computer

Connecting the Instruments

Connect DNA Engine and DNA Engine Tetrad cyclers via the IEEE-488 port on the
back of each instrument (see figs. 2-3 and 12-4), using high-quality cables. Although
several connection configurations are possible, we recommend a simple daisy chain
or star pattern. The DNA Engine cycler’s IEEE-488 interface is fully compatible with
both the IEEE-488.2 and the IEEE-488.1 standards. 

Assigning Address Numbers to Instruments

Each instrument must have a unique address number, which is assigned from its con-
trol panel. Address numbers cannot be assigned from the controller.

To assign an address number to a instrument, select Setup from the Main Menu, then
press «Proceed». The Setup Menu will be displayed:

Select Remote, then press «Proceed». A screen allowing choice of a port will be
displayed:

Setup:
_REMOTE Printer
Lid Version

Remote:
_SERIAL IEEE-448
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Select IEEE-488, then press «Proceed». The remote addressing screen will be displayed:

Enter an address number for the instrument. Set the controller DNA Engine cycler’s
address to 0. Give the other instruments in the network any number from 1 to 30.
Press «Cancel» to delete a number and enter a new one.

Running a Protocol on Networked Instruments

To run a protocol on networked instruments, use the controller to select a protocol
(see “Choosing a Stored Protocol to Run,” chapter 5), then press «Proceed». The net-
work screen for the controller will be displayed:

The protocol will be identified on the top line (2-STEP in the example above). The
single asterisk in the upper right-hand corner indicates that a single-block Alpha unit
is loaded into the controller. “Local” indicates that this is the controller’s network
screen, and “96V“ indicates the type of Alpha unit loaded into the controller.

If a Dual Alpha™ unit is loaded into the controller, press «Proceed» until the letter des-
ignating the desired block is displayed after the asterisk in the upper right-hand
corner of the screen. The letter A designates the right-hand block, and the letter B
the left-hand one (e.g., *A, *B). 

To run the protocol on the controller’s block, press «Proceed». One or more screens
for setting up the protocol’s temperature control method will be displayed (see
“Running a Protocol,” chapter 5). When these screens have been worked through,
the protocol will begin running. 

To run the protocol on a different instrument’s block, press «Block» until the screen
identifies the desired block (22 in the example below):

The instrument’s address number will be identified in the upper right-hand corner of
the screen. “Remote” indicates that this is the network screen for a slave unit, and
“60V” indicates the type of Alpha unit that has been selected. The status light for the
selected block will flash on the control panel of the instrument holding the block. 

Remote:
Serial _IEEE-448

Address (0-30): 0

Run: 2-STEP on *

Block: Local (96V)

Run: 2-STEP on 22

Block: Remote 60V
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If the right or left block of a dual-block Alpha unit has been selected, an A or B will
appear after the address number (e.g., 7-3A for the right-hand block in a Dual Alpha
unit loaded into quadrant 3 of a DNA Engine Tetrad at address 7.  See figure 12-1 for
a diagram of the layout of quadrants in the DNA Engine Tetrad cycler). 

Press «Cancel» at any time to abandon the selection process and display the Main
Menu again.

When the desired block is identified in the LCD window, press «Proceed». When you
have worked through the screens that set up the protocol’s temperature control
method, the protocol will begin running.

The protocol’s runtime screen will appear on the controller’s LCD window. The LCD
window of the instrument holding the active block will continue to show whatever
screen it was displaying before the protocol began running. 

Press «Block» to display the Main Menu on the controller again. Repeat the proce-
dure to run protocols on other networked blocks. Press «Block» on the controller to
progressively display the runtime screens of all networked blocks that are running
protocols. 

While protocols are running, other DNA Engine cycler functions (Edit, Enter, Files,
etc.) can be accessed on any individual instrument in the network, from that instru-
ment’s front panel.

Networking Instruments with a Computer

For users who wish to write their own software interface for computer control of Bio-
Rad DNA Engine® line thermal cyclers, including the DNA Engine (PTC-0200),
Bio-Rad provides a set of ASCII commands, or Remote Command Sets, for com-
munication with the cyclers.  These may be downloaded from www.bio-rad.com, or
obtained from Bio-Rad Technical Support.A computer-controlled network can be
connected via IEEE-488 cables or RS-232 (serial) cables.  In either case, the com-
puter acts as the controller of the network and uses the driver software to
communicate with the networked instruments.

Establishing Communication Using the Remote Interfaces

The DNA Engine remote control interface is based on the IEEE-488.2 standard. The
GPIB interface is fully compatible with both this standard and the IEEE-488.1 hard-
ware standard. 

The serial remote interface uses an identical command set which includes the IEEE-
488.2 required common commands. On a DNA Engine, multiple commands or
queries may be contained in one message as long as they are separated by semi-
colons. Corresponding responses to any queries will be returned in a single
message, also separated by semicolons.
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The IEEE-488 GPIB Remote Interface

To connect DNA Engine (and DNA Engine Tetrad) cyclers in a computer-controlled
IEEE-488 network, the computer must be equipped with an IEEE-488 (GPIB) inter-
face card. Connect the instruments and assign addresses as described under
“Networking Instruments Without a Computer” (p. 9-2). Make sure that none of the
networked instruments have been assigned IEEE-488 address 0 as this address is
reserved for a DNA Engine acting as system controller and will cause communication
problems with the computer.

All inputs (commands or queries) to the unit must be terminated with a NEWLINE
character (ASCII 10), an ^END hardware level command on the last data byte of the
message, or a NEWLINE^END combination following the last data byte of the mes-
sage. The preferred terminator is the NEWLINE^END combination. All outputs from
the unit (query responses) are terminated with a NEWLINE^END.

The RS-232 Serial Remote Interface

In a computer-controlled RS-232 (serial) network, each instrument in the network is
connected directly to the controlling computer via a serial port. The number of instru-
ments that can be included in such a network thus depends on the number of serial
ports available on the controlling computer.  Use high-quality null modem serial
cables to connect the serial port on each instrument (see figs. 2-3 and 12-4) to a
serial port on the computer. 

Use the Setup utilities to configure each instrument for serial communications (see
“Choosing a Remote Port,” chapter 8, and select the serial port and the 9600 baud
rate).  The Port Settings should also specify 8-bit data bytes, 1 stop bit, and no parity. 

All inputs to the unit must be terminated with a NEWLINE (ASCII 10). Each output
from the DNA Engine is terminated with a RETURN (ASCII 13) NEWLINE combina-
tion.
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Cleaning the DNA Engine® Cycler

Cleaning the Chassis and Block

Clean the outside of the DNA Engine cycler and Alpha™ unit with a damp, soft cloth or
tissue whenever something has been spilled on it or the chassis is dusty. A mild soap
solution may be used if needed.

Clean block wells with swabs moistened with water, 95% ethanol, or a 1:100 dilution
of bleach in water (see the Slide Chambers Alpha Unit Operations Manual for instruc-
tions on cleaning the Slide Chambers™ Alpha unit’s slide slots). If using bleach, swab
wells with water afterward to remove all traces of bleach. Clean spilled liquids out of
the block as soon as possible; dried fluids can be difficult to remove. Do not clean the
block with caustic or strongly alkaline solutions (e.g., strong soaps, ammonia, bleach
at a higher concentration than specified above). These will damage the block’s pro-
tective anodized coating, possibly causing electrical shorting. 

If you use oil in the block (a practice not recommended by Bio-Rad; see “Using Oil to
Thermally Couple Sample Vessels to the Block,” chapter 4), clean the wells whenever
the oil has become discolored or contains particulate matter. Use a swab to determine
whether cleaning is needed. Clean the block with 95% ethanol as described above. Oil
buildup must be prevented. Old oil harbors dirt, which interferes with vessel seating
and diminishes thermal coupling of sample vessels to the block.

Caution: Do not pour any cleaning solution into the block’s wells and then
heat the block, in an attempt to clean it. Severe damage to the
block, the heated lid, and the chassis will result.

Cleaning the Air Vents

Clean the air intake and exhaust vents with a soft-bristle brush, a damp cloth, or a
vacuum cleaner whenever dust is visible in them. The air intake vents are located on
the bottom, lower front edge, and back of the machine; the air exhaust vents are
located on both sides (see figs. 2-1, 2-3, and 2-4). If these vents become clogged
with dust and debris, airflow to the Alpha unit’s heat sink is hampered, causing per-
formance problems related to overheating. The air intake vents are particularly likely
to collect dust since their holes are much smaller than those of the air exhaust vents.

Tip: To prevent problems with overheating, institute a regular program of checking for
dust buildup, particularly for robotics installations.
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Cleaning Radioactive or Biohazardous Materials out of the
Block

When cleaning instruments that have been running radioactive or biohazardous reac-
tions, consult your institution’s radiation safety officer or biosafety officer regarding
cleaning methods, monitoring, and disposing of contaminated materials.

Changing the Fuses

The circuits in the DNA Engine cycler are protected by two fuses (6.3A fast-acting,
5x20mm). When a fuse blows, the DNA Engine cycler immediately shuts down and
cannot be turned back on. The machine records the event as a power loss, so if a
protocol is running when a fuse blows, the machine will resume the run when the fuse
is replaced and power restored (see “Resuming a Protocol after a Power Outage,”
chapter 5).

Warning: The DNA Engine cycler incorporates neutral fusing, which means
that live power may still be available inside the unit even when a
fuse has blown or been removed. Never open the DNA Engine
base. You could receive a serious electrical shock. Opening the
base will also void your warranty.

1.   Disconnect the power cord from the back of the instrument. Move the power
switch to the “0” (off) position. 

2.  Insert one corner of a small flat-head screwdriver just under the fuse plug (fig. 10-1A),
and gently pry the plug loose. Pull the plug straight out as far as it will go, then push
it downward to expose the fuses (fig. 10-2B).

3.  Remove both fuses and replace them with new ones (it is impossible to visually
determine which fuse is blown). You may also test the fuses with an ohmmeter to
determine which is defective and replace just that one.

4.   Gently press the fuse cover back in place, and reconnect the power cord. 

Figure 10-1 A, Removing the fuse plug.                  B, Location of the fuses in the opened plug.

A B

Fuse plug

Fuse plug

FuseFuse

Screwdriver
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Error Messages

Note: The DNA Engine® and DNA Engine Tetrad® software is highly sensitive with
respect to block and heat-sink errors. When such errors messages occur, try
restarting the protocol. If the message fails to reappear, proceed as usual.

Error Message Cause Action

A / C Power Failed,
Cycle XXX Step X,
Recovered at XX.X°

Displayed when a machine running
a protocol has been turned off,
either intentionally or due to a
power outage, and then turned on
again.

No action is necessary. Protocol
resumes running when power is
restored Results may or may not
be affected, depending on whether
power failed in an early or a late
cycle, and whether the power was
restored before the sample cooled
excessively.

Block Overheated,
Return for Service

On machines with software ver-
sions below 1.1M, can happen
when running calculated-control
protocols with target temperatures
of 103°–105°C. As the calculated-
control algorithm tries to hold
samples at such high tempera-
tures, it can heat the block to
temperatures in excess of the
Alpha™ unit’s maximum allowable
temperature (107.5°C), triggering
an automatic Alpha unit shutdown.

Determine machine’s software ver-
sion number (see p. 8-9). If number
is below 1.1M, contact Bio-Rad or
your local distributor to request a
software version upgrade.

Sensor malfunction allows base to
heat block over its maximum
allowable temperature, triggering
an automatic Alpha unit shutdown.

Alpha unit and/or base needs 
servicing. Contact Bio-Rad or 
your local distributor.

Block Sensor Fault, Left
Ignored (Center Ignored,
Right Ignored)

Left, center, or right temperature
sensor in Alpha unit is not working
properly, so machine is now
ignoring it and relying on remaining
sensors to monitor block tempera-
ture. 

Alpha unit needs servicing soon.
Contact Bio-Rad or your local 
distributor.

Block Sensor Fault,
Program Terminated.

None of the temperature sensors
in Alpha unit are working properly,
so Alpha unit has been shutdown.  

Alpha unit and/or base needs 
servicing. Contact Bio-Rad or 
your local distributor.
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Error Message Cause and Result Action

Calc Control, Probe
Mode Invalid

Runtime error indicating a gradient
step is being programmed under
Probe Control mode.

Change to Calc control mode.

Gradient Fault, Service
Alpha soon.

Displayed at end of run.  Indicates
gradient was not achieved within
20 sec of block reaching target.

Alpha unit and / or base needs
servicing.  Contact Bio-Rad or your
local distributor.

Gradient Program,
Invalid Alpha Type.

Runtime error indicating gradient is
being programmed for an Alpha
module other than a 96V.

Use 96V Alpha nodule.

Heated Lid Fault,
Program Terminated.

Lid sensor failed during preheat,
so Alpha unit has been shut down. 

Heated lid or base needs servicing
Contact Bio-Rad or your local dis-
tributor.

HS Overheated,
Program Terminated

Machines are not getting enough
air, or air being taken in is warmer
than 31°C.

Make sure machine gets enough
air and that temperature of air
being taken in is 31°C or  cooler
(see p. 3-3).  Correct air supply
problems and run protocol again.
If error message persists, base
may need servicing.  Contact
Bio-Rad or your local distributor.

Machine is running a protocol con-
sisting of many cycles of only a few
seconds each.  Alpha unit heat sink
does not have time to dissipate
heat generated by rapid cycling.
Eventually its maximum allowable
temperature is exceeded, and
Alpha unit is shut down.

Contact Bio-Rad or your local dis-
tributor to discuss protocol.

Sensor malfunction has allowed
base to heat block over its max-
imum allowable temperature
(107.5°C), triggering automatic
Alpha unit shutdown. 

Alpha unit and / or base needs
servicing.  Contact Bio-Rad or
your local distributor.

HS Overheating, 
Check Air Flow 

See causes for “HS Overheated,
Program Terminated.” 

See actions for “HS Overheated,
Program Terminated.”

HS/PS Sensor Fault,
Program Terminated.

Heat sink sensor in Alpha unit and
power supply sensor in base are
not working, so Alpha unit has
been shut down.

Alpha unit or base needs servicing.
Contact Bio-Rad or your local dis-
tributor.
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Error Message Cause and Result Action

HS Sensor Fault, Alt
Control Mode

Alpha unit heat sink sensor is not
functioning properly, so machine
has begun estimating heat sink
temperature based on other tem-
perature sensor readings.

Alpha unit needs servicing soon.
Contact Bio-Rad or your local dis-
tributor.

HS Sensor Fault, Left
Ignored.

Same as previous Same as previous

HS Sensor Fault, Right
Ignored.

Same as previous Same as previous

Internal Fan Fault,
Return for Service 

Fan inside base is not working, so
Alpha unit has been shut down. 

Fan must be repaired.  Contact
Bio-Rad or your local distributor.

Lid Sensor Fault, 
Lid Was Disabled.

Heated lid is giving unexpected
temperature readings, so base has
turned it off.  Protocols can still be
run, but reactions may fail because
of condensation in vessels.

Alpha unit needs servicing soon.
Contact Bio-Rad or your local dis-
tributor. 

L/R Power Imbalance Thermoelectric units in Alpha unit
block are not heating uniformly, so
machine begins delivering equal
power to all heating elements.
Protocols may still be run, but
reactions may fail due to uneven
block temperatures.

Alpha unit needs servicing soon.
Contact Bio-Rad or your local 
distributor.

Memory Is Corrupt! Rarely seen message indicating
that memory has been corrupted
by a static shock or other unusual
electronic incident.

Base needs servicing. Contact
Bio-Rad or your local distributor.

No Memory 
Available!

All available memory has been
filled. 

Delete unused protocols and
folders from memory.  Reduce size
of stored programs by using GoTo
and the Inc and Ext options (see
chapter 6). 

Probe Sensor Fault, 
Used Calc Control

Either probe sensor is not working
properly or a probe-control pro-
tocol was run without probe being
installed.  Machine has switched
temperature control method to 
calculated control. 

Make sure probe is installed when
running probe-control programs.  If
error message persists, replace
probe.
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Error Message Cause and Result Action

PS Overheated, 
Program Terminated

Machine is not getting enough air,
or air being taken in is warmer
than 31°C.

Make sure that machine is getting
enough air and that temperature of
air being taken in is 31°C or cooler
(see p. 3-3).  Correct any air supply
problems and run protocol again.
If error message persists, base
may need servicing.  Contact
Bio-Rad or your local distributor.

Machine is running a protocol con-
sisting of many cycles of only a few
seconds each.  Alpha unit heat sink
does not have time to dissipate
heat generated by rapid cycling.
Eventually its maximum allowable
temperature is exceeded, and
Alpha unit is shut down.

Contact Bio-Rad or your local dis-
tributor to discuss protocol.

PS Overheating, 
Check Air Flow

See causes for “PS Overheating,
Program Terminated.”

See actions for “PS Overheating,
Program Terminated.”

PS Sensor Fault, 
Temp Ignored

Power supply sensor is not
working properly.  Protocols can
still be run, but machine should be
serviced soon to repair sensor.

Base needs servicing.  Contact
Bio-Rad or your local distributor.

Slow Block Cycling, 
Service Alpha Soon

Alpha unit block has not reached
target temperature within expected
time.  Unit will begin beeping, and
will continue to beep until target
temperature is reached, protocol is
manually progressed to its next
step (see p.5-8), or protocol run is
halted.  Problem often results from
machine not getting enough air, or
taking air that is warmer than 31°C.

Make sure that machine is getting
enough air and that temperature of
air being taken in is 31°C or cooler
(see p. 3-3).  Correct any air supply
problems and run protocol again.
If error message persists, software
upgrade may be needed or base
may need servicing.  Contact
Bio-Rad or your local distributor.

Slow Lid Cycling, 
Service Alpha Soon

Alpha unit lid has not reached
target temperature within expected
time.  Unit will begin beeping, and
will continue to beep until target
temperature is reached, protocol is
manually progressed to its next
step (see p.5-8), or protocol run is
halted.

Alpha unit lid needs servicing
soon.  Contact Bio-Rad or your
local distributor.

Unit Failure/
Unit X Failure
(Tetrad)

The self-test has failed because of
a problem with the base or the
Alpha unit. 

Contact Bio-Rad or your local dis-
tributor.
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Problems Related to Protocols

Following is a general description of some common problems related to the protocols
and reaction components in sequencing and amplification applications. For a more
detailed discussion of protocols and reactions, see Current Protocols in Molecular
Biology (F. Ausubel et al., eds., John Wiley & Sons), specifically chapters 7 (DNA
sequencing), 14 (in-situ hybridization and immunology), and 15 (polymerase chain
reaction).

Error Message Cause and Result Action

Reaction is working, but
broad low-molecular
weight band is seen 
in gels.

“Primer-dimer” material often pro-
duces a broad band in the <100 bp
region of gels.

If obtaining appropriate reaction
product/s, no need to change 
anything.

Minimize “primer-dimer” production
by designing primers with no 3'
self-complementary.

Reoptimize magnesium concentra-
tion and annealing temperature to
maximize desired product and
minimize “primer-dimers”.

Reaction working, but
unexpected extra prod-
ucts or smear is seen.

Nonspecific hybridization occurring
during setup. 

Program a hot start into the 
protocol.

Reaction component concentration
too high or too low.

Check concentrations of compo-
nents. May need to reoptimize
magnesium concentration. 

Annealing temperature too low. Reoptimize annealing temperature.

Protocol contains a wrong value. Use List utility to check protocol’s
temperature control method, tem-
peratures, and times.

Template not of sufficient purity. Check extraction and purification
protocols. Add additional purifica-
tion steps if necessary. 

Multiple templates or host DNA in
sequencing reactions. 

Check nucleic acid preparations
by gel electrophoresis.
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Problem Cause Action

No reaction products
obtained.

Wrong protocol used. Re-run reaction using correct 
protocol.

Protocol contains a wrong value. Use List utility to check protocol’s
temperature control method, tem-
peratures, and times.

Reaction component omitted from
mixture.

Check reaction assembly protocol,
ensuring that mixture contains
appropriate components in correct
concentrations.

Denaturation temperature too 
low.

Use >92°C for denaturation.

Annealing temperature too high for
primers.

Check for appropriate annealing
temperatures of primers, using
available computer programs or
empirical testing. 

Wrong temperature control method
used.

Use List utility to check tempera-
ture control method for protocol;
change if needed.

Probe failed, causing machine to
run protocol under calculated 
control.

Check screen for probe failure
error message. Probe may need
servicing or replacing.  Contact
Bio-Rad or your local distributor.

Probe not filled with correct
amount of oil. 

Fill probe tube with correct amount
of oil. (see p. 4-11).

Reaction mix contains an inhibitor
(e.g., heme from blood). 

Spike a complete reaction mix with
a control template and primer set.

Reaction vessels not making good
thermal contact with sample block.

Use only high-quality tubes/plates
that fit block snugly.  Ensure that
wells are free of foreign materials
that would interfere with tube/plate
seating.
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Problems Related to Environmental Conditions, Setup, and
Maintenance

Problem Cause Action

Frequent shutdowns
due to overheating.
Frequent “Slow Block
Cycling,” and “HS
Overheating” error 
messages.

Machine is not receiving enough
air.

Make sure air intake vents ar not
obstructed by dust, debris, or
paper.  Remove light collections of
dust and debris with damp cloth.
Vacuum out heavy collections.
Remove any papers placed under
the machine at least 10cm from
vertical surfaces.

Air flowing into vents is not 
<31°C.

Check temperature of air entering
air intake vents, following procedure
on p. 3-3.  If higher than 31°C, use
table 3-1 to troubleshoot and
remove cause / s.

Dust and debris clog-
ging up air intake vents.

Failure to regularly check for
buildup.

Remove light collections damp
cloth.  Vacuum out heavy 
collections.
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About the Remote Alpha Dock System

The Remote Alpha Dock (RAD) system is designed to add flexibility to the installation
and operation of the Bio-Rad DNA Engine® and DNA Engine Tetrad® cyclers.  The
system allows Alpha™ units to be placed at a distance from the cycler base, enabling
more efficient use of space and facilitating robotic operation.  The basic system, the
RAD-0200, comprises a Dock Connector, which mounts in the base, and a
Remote Alpha Dock, into which the Alpha units are mounted.  The RAD-0201 con-
tains, in addition, a fan power supply and three serial cables, allowing the cooling fans
for up to four remote docks to run off a single AC outlet.  Additionally, the fan power
supply along with the cables to run up to four Remote Alpha Dock fans from a single
thermal cycler base can be purchased separately, as RPS-0200.

Figure 13-1 The Remote Alpha Dock with an Alpha unit mounted
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Packing checklist

•     One Dock Connector

•     One Remote Alpha Dock

•     One multi-pin power cable 

•     One multi-pin data cable

•     One fan power supply (RAD-0201 only) 

•     One wall-plug power cord (RAD-0201 only)

•     Three round-jack power cords (RAD-0201 only)

Requirements

Environment

The Remote Alpha Dock System allows for custom installations. The following place-
ment configurations are recommended by Bio-Rad.

•   Remote Docks with mounted Alpha units may be configured in any horizontal ori-
entation or array as long as a minimum side clearance of 10cm is maintained
between the Remote Dock and any wall, bulkhead, or adjacent Remote Dock unit 

Figure 13-2 Remote Alpha Dock and Dock Connector, bottom view.

Keying plug

Ground lead
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(this is identical to the PTC-200/PTC-225 base requirement).  Requirements for
motorized lid operation or for loading or unloading plates may dictate additional
clearances.

•   Remote Docks with mounted Alpha units may be stacked vertically as long as a
minimum bottom clearance is maintained that would be no less than that
resulting from the unit being placed on a solid horizontal platform. A minimum top
clearance is also required to allow access to and operation of the Alpha unit lid.

•   Remote Docks can be flush-mounted (i.e., with the feet removed) to facilitate
robotic operation, as long as the airway beneath the unit is equivalent to the
airway the unit would have with the feet attached. Usually a hole will need to be
cut to allow air to flow to the cooling fan. Figure 13-5 is a template for flush-
mounting the Remote Dock.  

Power Supply 

•   The Alpha unit mounted in each Remote Dock is powered from the thermal cycler
base.  

•   The Remote Dock’s fan is powered externally, and a power supply is provided that
requires power from 90-250VAC and 47-63Hz, with a grounded outlet.

Air Supply 

•    Alpha units being operated in the remote configuration have no operating con-
straints that do not also apply to normal operations in the PTC-200 or PTC-225. 

Figure 13-3 Attachment of power and data cables

Dock connector

Remote dock

Data port Power port
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Installation

1.  Turn the Dock Connector upside down, so that the green circuit board is visible.
Check that the ground lead remains attached at both ends (fig. 13-2). Note the
two female multi-pin sockets, one labeled “DATA,” and the other “POWER.”

2.  Connect the multi-pin power cable’s male end to the female socket labeled
“POWER” and slide the latch to lock the pins in place.

3.  Both of the data cable’s multi-pin connectors are male: one is labeled “CON-
NECTOR DATA” and the other “DOCK DATA.”  Attach the “CONNECTOR DATA”
end to the female connector labeled “DATA” on the circuit board and slide the
latch to lock the pins in place.

4.  Press both cables firmly into the two strain relief holes on the Dock Connector’s
front side (fig. 13-3).

5.  Turn the Remote Dock upside down. You will see a male multi-pin connector
labeled “Power Port” and a female multi-pin connector labeled “Data Port” (fig.
13-3). 

6.  Connect the multi-pin power cable’s female end to the connector labeled “Power
Port” and slide the latch to lock the pins in place.

7.  Attach the data cable’s “DOCK DATA” end to the connector labeled “Data Port”
and slide the latch to lock the pins in place.

8.  Turn both units back over.

Figure 13-4 Fan power supply connected in series
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9.    The Dock Connector mounts in the cycler base and in the same manner as a
regular Alpha unit (see Chapter 4). 

10.  Attach the wall-plug power cord to the fan power supply.

11.  Attach the fan power supply’s round jack to either of the round connectors on
the back of the Remote Dock (fig. 13-4).  

12.  The fan power supply produces sufficient current such that up to three additional
fans can be “daisy chained” to the initial Remote Dock via the round-jack power
cords supplied. Attach one end of the cord to the initial unit’s free round con-
nector. Attach the other end to either of the round connectors on the back of the
next Remote Dock in the series, and so on (fig. 13-4). This allows all the RADs
connected from a single multi-bay thermal cycler to operate using a single fan
power supply. 

13. When the RAD system has been completely set up, connect the fan power
supply’s wall plug to a power source. 

Operation

The remote system is transparent to the base unit; i.e., the Dock Connector allows
the base to control the Alpha unit in the Remote Dock as if it were in the standard
configuration.  

Important: Turn the base unit’s power off when changing the type of
sample block you are using. Turning the power off resets the
base, allowing it to recognize the new block. If not reset, the
base unit assumes that the previous type of block is installed,
resulting in error messages and procedural faults.
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Figure 13-5 Flush-mounting template
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Appendix A: Warranty
InformationA

The DNA Engine® (PTC-0200) thermal cycler is warranted against defects in materials
and workmanship. For specific warranty information, contact your local Bio-Rad
office. If any defects should occur during the warranty period, Bio-Rad will replace
the defective parts without charge. However, the following defects are specifically
excluded:

1. Defects caused by improper operation or by improper packaging of returned
goods.

2. Repair or modifications done by anyone other than Bio-Rad Laboratories.

3. Use with tubes, plates, or sealing materials not specified by Bio-Rad
Laboratories for use with the DNA Engine thermal cycler.

4. Deliberate or accidental misuse.

5. Damage caused by disaster.

6. Damage due to use of improper solvent or sample.

The warranty does not apply to fuses.

For inquiry or request for repair service, contact Bio-Rad Laboratories after confirming
the model and serial number of your instrument.
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B Appendix B: Factory-
Installed Protocols

Standard 2-step PCR protocol

STD-2
Step  Temp Time
1 95 4:00
2 95 :30
3 65 :30
4 GOTO 2, 29X
5 4 ∞
6 END

Standard 3-step PCR protocol

STD-3
1 95 4:00
2 95 :30
3 55 :30
4 72 :30
5 GOTO 2, 29X
6 72 7:00
7 4 ∞
8 END

Touchdown PCR protocol

TCHDOWN
1 95 4:00
2 95 :30
3 60 :30 

(Increment -0.5°C/cycle)
4 72 :30
5 GOTO 2, 29X
6 95 :30
7 45 :30
8 72 30
9 GOTO 6, 29X
10 72 7:00
11 4 ∞
12 END

2-step Fast PCR protocol using
iTaq™ polymerase

iTAQ-FST
Step  Temp Time
1   98 :30
2 92 :01
3 70 :10
4 GOTO  2, 34X
5 72 :15
6 END

2-step PCR protocol using iProof™

high-fidelity polymerase for small,
intermediate, and long templates

iPRF1kb
1 95 2:00
2 95 :05
3 72 :30
4 GOTO  2, 219X
5 72 10:00
6 END

iPRF8kb
1 95 2:00
2 95 :05
3 72 4:00
4 GOTO  2, 19X
5 72 10:00
6 END

iPRF15kb
1 95 2:00
2 95 :05
3 72 7:30
4 GOTO  2, 19X
5 72 10:00
6 END
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2-step RT PCR protocol

RTPCR-2
Step  Temp Time
1 37 60:00
2 95 5:00
3 95 :30
4 65 :30
5 GOTO 3, 39X
6 72 7:00
7 4 ∞
8 END

3-step RT PCR protocol

RTPCR-3
1 37 60:00
2 95 5:00
3 95 :30
4 55 :30
5 72 :30
6 GOTO 3, 39X
7 72 7:00
8 4 ∞
9 END

2-step nested primer protocol

NEST PR2
1 95 4:00
2 95 :30
3 65 :30
4 GOTO 2, 39X
5 72 7:00
6 4 ∞
7 95 :30
8 65 :30
9 GOTO 7, 39X
10 72 7:00
11 4 ∞
12 END

3-step nested primer protocol

NEST PR3
Step  Temp Time
1 95 4:00
2 95 :30
3 55 :30
4 72 :30
5 GOTO 2, 39X
6 72 7:00
7 4 ∞
8 95 :30
9 55 :30
10 72 :30
11 GOTO 8, 39X
12 72 7:00
13 4 ∞
14 END

2-step long PCR protocol using
iTaq polymerase

LONG-2
1 95 4:00
2 95 :30
3 65 3:00 Ext 15s/cycle
4 GOTO 2, 34X
5 72 7:00
6 4 ∞
7 END

3-step long PCR protocol using
iTaq polymerase

LONG-3
1 95 4:00
2 95 :30
3 55 :30
4 72 3:00     Ext 15s/cycle
5 GOTO 2, 34X
6 72 7:00
7 4 ∞
8 END
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I n d e x

A
Air supply requirements

ensuring adequate air supply  3-3

ensuring air is cool enough  3-4

troubleshooting problems with  3-4

Alpha units

closing  4-5

installing  4-4

models  2-4

opening  4-5

removing  4-5

B
Baud rate, setting  8-7

Beep option. See Programs: options, types of

Bleach, using in block  10-2

C
Chill-out liquid wax  4-7

Cleaning

air vents  10-2

and biohazardous materials  10-3

and radioactive materials  10-3, 4-13

chassis and block 10-2

removing oil from block  10-2

solutions to use  4-13

Condensation in tubes following holds  4-7

Control panel  2-2
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keys  4-3

lights  4-3

using  4-3

D
Documentation conventions

graphic  vi

terminology  vi

typographic  vi

E
Electromagnetic interference  v

Environmental requirements  3-2–3-3

Error messages  11-2

Explanation of symbols  iv

Extend option. See Programs: options, types of

F
FCC warning  v

Fuses

changing  10-3

H
Hot Bonnet lid

adjusting lid pressure  4-8–4-9

temperature control methods  8-8

I
Increment option. See Programs: options, types of

Instant incubation  5-9

L
Layout

back view  2-3

bottom view  2-3

control panel  2-2
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front view  2-2

M
Menus

Edit Menu  7-2

Enter Menu  6-5

Files Menu  8-2

Main Menu  4-2

Options Menu  6-5

Setup Menu  8-7

Microseal

‘A’ film  4-8

‘B’ adhesive seals  4-8

‘F’ foil  4-8

'P'/'P+' pads  4-8

Moto Alpha unit  2-4

N
Networking

general information  9-2

with computer as controller  9-4

setting up an IEEE-488 network  9-5

setting up an RS-232 network  9-5

with DNA Engine cycler as controller  9-2

assigning address numbers  9-2

connecting machines  9-2

running protocols  9-3

O
Oil, use of in block. See Sample vessels

Operation

turning machine on  4-2

P
Packing checklist  3-2
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Passwords. See Utilities: files: assigning password to folder

Ports  2-5, 4-3

IEEE-488  2-3

parallel (printer)  2-3

RS-232  2-3

Power cord

location of jack  2-3

plugging in  3-2

Power supply requirements  3-3

acceptable power cords  3-3

Programming

choosing a temperature control method  6-6

deleting a program  6-19

entering steps

beep option  6-17

end step  6-14

extend option  6-16

GoTo step  6-13

gradient step  6-8

increment option  6-15

ramp step  6-12

temperature step  6-7

general process  6-5

initiating a program  6-5

modifying block--control programs 6-5

modifying programs designed for other machines  6-5

naming a program  6-6

setting a lengthy hold time  6-8

Programs

designing  6-2–6-5

choosing temperature control method. See Temperature control methods

translating protocol into programs  6-3
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using GoTo steps to shorten programs  6-3

editing  7-2, 7-3

adding an option  7-4

cancelling editing changes  7-5

deleting step  7-4

inserting new step  7-4

saving edited program  7-4

finding in machine  5-2, 7-2, 8-2

options, types of  6-2, 6-15

program steps, types of  6-2

renaming. See Utilities: file

Protocols

and power failure  5-8

factory-installed  5-2,  B-1

manually stepping through  5-7

pausing while running  5-7

printing logs for runs  5-6–5-7

running

choosing block to run protocol on  5-3

choosing protocol to run  5-2

reading completion screen  5-6

reading runtime screen  5-5

setting up temperature control method  5-3

three steps of  5-2

stopping while running  5-8

protocols

adjusting for sample vessel type  4-6

S
Safety

general instructions  1-3

guideline for safe use  v

warnings  iv
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Sample vessel

selection chart  4-11

Sample vessels

ensuring good thermal contact  4-10

loading into block  4-9

sealing

reason for  4-7

with Hot Bonnet lid and caps/film  4-7

with oil or wax  4-7

selection  4-6

0.2 ml tubes  4-6

0.5 ml tubes  4-6

microplates  4-6

use of oil to improve thermal contact with block  4-10

Self-test  4-2

Setting machine up. See also Alpha units, installing

Shipping instructions A-1

Specifications  2-5

T
Temperature control methods

block control  6-4

calculated control  6-4

U
Utilities

file

assigning password to folder  8-3

copying program  8-4

creating folder  8-3

deleting a program  8-5

deleting folder  8-4

moving a program  8-5
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printing a program  8-6

renaming programs  8-5

viewing a program in LCD window  8-6

setup  8-7

choosing a printer port  8-8

choosing a remote port  8-7

choosing a temperature control method for the Hot Bonnet lid  8-8

determining software version number  8-9

W
Warranty information  A-1
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Declaration of Conformity

Bio-Rad Laboratories, Inc., 1000 Alfred Nobel Drive, Hercules, California,
94547, U.S.A., declares that the product

PTC0200, The DNA Engine® Thermal Cycler

to which this declaration relates, is in conformity to the following standards 
or normative documents. 

IEC61010-1
EN61326: CLASS A

following the provisions of the 73/23/EEC, 89/336/EEC & 93/68/EEC
Directive.

This product is imported into the EU by Bio-Rad Laboratories, Ltd., Bio-Rad
House, Maxted Road, Hemel Hempstead (London area), Hertfordshire
HP2 7DX England.

13 September, 2004
date of issue

Brad Crutchfield
Vice President

11142 rev B





Technical Service:
Call your local Bio-Rad office, or in the U.S. 
call 1-800-4BIORAD (1-800-424-6723).

Bulletin 05434   US/EG   Rev D 05-0869   1205   Sig 1205

Life Science
Group

Bio-Rad 
Laboratories, Inc.

Web site www.bio-rad.com  USA 800 4BIORAD  Australia 02 9914 2800  Austria 01 877 89 01  Belgium 09 385 55 11  Brazil 55 21 3237 9400  
Canada 905 712 2771  China 86 21 6426 0808  Czech Republic 420 241 430 532  Denmark 44 52 10 00  Finland 09 804 22 00  France 01 47 95 69 65  
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<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


